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About This Documentation Preface

JD Edwards EnterpriseOne implementation guides provide you with the information that you need to implement and
use JD Edwards EnterpriseOne applications from Oracle.

This preface discusses:

» JD Edwards EnterpriseOne application prerequisites.

Application fundamentals.

Documentation updates and printed documentation.
Additional resources.

Typographical conventions and visual cues.
Comments and suggestions.

Common fields in implementation guides.

Note. Implementation guides document only elements, such as fields and check boxes, that require additional
explanation. If an element is not documented with the process or task in which it is used, then either it requires no
additional explanation or it is documented with common fields for the section, chapter, implementation guide, or
product line. Fields that are common to all JD Edwards EnterpriseOne applications are defined in this preface.

JD Edwards EnterpriseOne Application Prerequisites

To benefit fully from the information that is covered in these books, you should have a basic understanding of
how to use JD Edwards EnterpriseOne applications.

You might also want to complete at least one introductory training course, if applicable.

You should be familiar with navigating the system and adding, updating, and deleting information by using JD
Edwards EnterpriseOne menus, forms, or windows. You should also be comfortable using the World Wide
Web and the Microsoft Windows or Windows NT graphical user interface.

These books do not review navigation and other basics. They present the information that you need to use the
system and implement your JD Edwards EnterpriseOne applications most effectively.

Application Fundamentals

Each application implementation guide provides implementation and processing information for your JD
Edwards EnterpriseOne applications.

For some applications, additional, essential information describing the setup and design of your system
appears in a companion volume of documentation called the application fundamentals implementation guide.
Most product lines have a version of the application fundamentals implementation guide. The preface of each
implementation guide identifies the application fundamentals implementation guides that are associated

with that implementation guide.
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General Preface

The application fundamentals implementation guide consists of important topics that apply to many or all JD
Edwards EnterpriseOne applications. Whether you are implementing a single application, some combination
of applications within the product line, or the entire product line, you should be familiar with the contents
of the appropriate application fundamentals implementation guides. They provide the starting points for
fundamental implementation tasks.

Documentation Updates and Printed Documentation

Xii

This section discusses how to:

* Obtain documentation updates.

* Order printed documentation.

Obtaining Documentation Updates

You can find updates and additional documentation for this release, as well as previous releases, on Oracle’s
PeopleSoft Customer Connection website. Through the Documentation section of Oracle’s PeopleSoft
Customer Connection, you can download files to add to your Implementation Guides Library. You’ll find

a variety of useful and timely materials, including updates to the full line of JD Edwards EnterpriseOne
documentation that is delivered on your implementation guides CD-ROM.

Important! Before you upgrade, you must check Oracle’s PeopleSoft Customer Connection for updates to the
upgrade instructions. Oracle continually posts updates as the upgrade process is refined.

See Also

Oracle’s PeopleSoft Customer Connection, http://www.oracle.com/support/support_peoplesoft.html

Ordering Printed Documentation

You can order printed, bound volumes of the complete line of JD Edwards EnterpriseOne documentation that
is delivered on your implementation guide CD-ROM. Oracle makes printed documentation available for each
major release of JD Edwards EnterpriseOne shortly after the software is shipped. Customers and partners
can order this printed documentation by using any of these methods:

* Web
* Telephone
¢ Email

Web

From the Documentation section of Oracle’s PeopleSoft Customer Connection website, access the
PeopleBooks Press website under the Ordering PeopleBooks topic. Use a credit card, money order, cashier’s
check, or purchase order to place your order.

Telephone
Contact MMA Partners, the book print vendor, at 877 588 2525.

Copyright © 2006, Oracle. All rights reserved.
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Email

Send email to MMA Partners at peoplebookspress@mmapartner.com.

See Also

Oracle’s PeopleSoft Customer Connection, http://www.oracle.com/support/support_peoplesoft.html

Additional Resources

The following resources are located on Oracle’s PeopleSoft Customer Connection website:

Resource Navigation
Application maintenance information Updates + Fixes
Business process diagrams Support, Documentation, Business Process Maps
Interactive Services Repository Support, Documentation, Interactive Services Repository
Hardware and software requirements Implement, Optimize, and Upgrade; Implementation

Guide; Implementation Documentation and Software;
Hardware and Software Requirements

Installation guides Implement, Optimize, and Upgrade; Implementation
Guide; Implementation Documentation and Software;
Installation Guides and Notes

Integration information Implement, Optimize, and Upgrade; Implementation
Guide; Implementation Documentation and Software;
Pre-Built Integrations for PeopleSoft Enterprise and JD
Edwards EnterpriseOne Applications

Minimum technical requirements (MTRs) (JD Edwards Implement, Optimize, and Upgrade; Implementation
EnterpriseOne only) Guide; Supported Platforms

Documentation updates Support, Documentation, Documentation Updates
Implementation guides support policy Support, Support Policy

Prerelease notes Support, Documentation, Documentation Updates,

Category, Release Notes

Product release roadmap Support, Roadmaps + Schedules

Release notes Support, Documentation, Documentation Updates,
Category, Release Notes

Release value proposition Support, Documentation, Documentation Updates,
Category, Release Value Proposition

Statement of direction Support, Documentation, Documentation Updates,
Category, Statement of Direction
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Resource Navigation
Troubleshooting information Support, Troubleshooting
Upgrade documentation Support, Documentation, Upgrade Documentation and
Scripts

Typographical Conventions and Visual Cues

This section discusses:

* Typographical conventions.
* Visual cues.
» Country, region, and industry identifiers.

* Currency codes.

Typographical Conventions

This table contains the typographical conventions that are used in implementation guides:

Typographical Convention or Visual Cue Description

Bold Indicates PeopleCode function names, business function
names, event names, system function names, method
names, language constructs, and PeopleCode reserved
words that must be included literally in the function call.

Italics Indicates field values, emphasis, and JD Edwards
EnterpriseOne or other book-length publication titles.
In PeopleCode syntax, italic items are placeholders for
arguments that your program must supply.

We also use italics when we refer to words as words or
letters as letters, as in the following: Enter the letter O.

KEY+KEY Indicates a key combination action. For example, a plus
sign (+) between keys means that you must hold down
the first key while you press the second key. For ALT+W,
hold down the ALT key while you press the W key.

Monospace font Indicates a PeopleCode program or other code example.

733

(quotation marks) Indicate chapter titles in cross-references and words that
are used differently from their intended meanings.

Xiv Copyright © 2006, Oracle. All rights reserved.
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Typographical Convention or Visual Cue Description

.. . (ellipses) Indicate that the preceding item or series can be repeated
any number of times in PeopleCode syntax.

{ } (curly braces) Indicate a choice between two options in PeopleCode
syntax. Options are separated by a pipe (| ).

[ 1 (square brackets) Indicate optional items in PeopleCode syntax.

& (ampersand) When placed before a parameter in PeopleCode syntax,
an ampersand indicates that the parameter is an already
instantiated object.

Ampersands also precede all PeopleCode variables.

Visual Cues

Implementation guides contain the following visual cues.

Notes

Notes indicate information that you should pay particular attention to as you work with the JD Edwards
EnterpriseOne system.

Note. Example of a note.

If the note is preceded by Important!, the note is crucial and includes information that concerns what you must
do for the system to function properly.

Important! Example of an important note.

Warnings

Warnings indicate crucial configuration considerations. Pay close attention to warning messages.

Warning! Example of a warning.

Cross-References

Implementation guides provide cross-references either under the heading “See Also” or on a separate line
preceded by the word See. Cross-references lead to other documentation that is pertinent to the immediately
preceding documentation.

Country, Region, and Industry Identifiers

Information that applies only to a specific country, region, or industry is preceded by a standard identifier in
parentheses. This identifier typically appears at the beginning of a section heading, but it may also appear
at the beginning of a note or other text.
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Example of a country-specific heading: “(FRA) Hiring an Employee”

Example of a region-specific heading: “(Latin America) Setting Up Depreciation”

Country Identifiers

Countries are identified with the International Organization for Standardization (ISO) country code.

Region Identifiers

Regions are identified by the region name. The following region identifiers may appear in implementation
guides:

» Asia Pacific

* Europe

* Latin America

* North America
Industry Identifiers

Industries are identified by the industry name or by an abbreviation for that industry. The following industry
identifiers may appear in implementation guides:

» USF (U.S. Federal)
* E&G (Education and Government)

Currency Codes

Monetary amounts are identified by the ISO currency code.

Comments and Suggestions

Your comments are important to us. We encourage you to tell us what you like, or what you would like to see
changed about implementation guides and other Oracle reference and training materials. Please send your
suggestions to Documentation Manager, Oracle Corporation, 7604 Technology Way, Denver, CO, 80237. Or
email us at documentation us@oracle.com.

While we cannot guarantee to answer every email message, we will pay careful attention to your comments
and suggestions.

Common Fields Used in Implementation Guides

Address Book Number Enter a unique number that identifies the master record for the entity. An
address book number can be the identifier for a customer, supplier, company,
employee, applicant, participant, tenant, location, and so on. Depending on
the application, the field on the form might refer to the address book number
as the customer number, supplier number, or company number, employee
or applicant ID, participant number, and so on.

Xvi Copyright © 2006, Oracle. All rights reserved.



As If Currency Code

Batch Number

Batch Date

Batch Status

Branch/Plant

Business Unit

Category Code

Company

Currency Code

Document Company

General Preface

Enter the three-character code to specify the currency that you want to use

to view transaction amounts. This code enables you to view the transaction
amounts as if they were entered in the specified currency rather than the
foreign or domestic currency that was used when the transaction was originally
entered.

Displays a number that identifies a group of transactions to be processed by
the system. On entry forms, you can assign the batch number or the system
can assign it through the Next Numbers program (P0002).

Enter the date in which a batch is created. If you leave this field blank, the
system supplies the system date as the batch date.

Displays a code from user-defined code (UDC) table 98/IC that indicates the
posting status of a batch. Values are:

Blank: Batch is unposted and pending approval.

A: The batch is approved for posting, has no errors and is in balance, but
has not yet been posted.

D: The batch posted successfully.
E: The batch is in error. You must correct the batch before it can post.

P: The system is in the process of posting the batch. The batch is unavailable
until the posting process is complete. If errors occur during the post, the
batch status changes to E.

U: The batch is temporarily unavailable because someone is working with
it, or the batch appears to be in use because a power failure occurred while
the batch was open.

Enter a code that identifies a separate entity as a warehouse location, job,
project, work center, branch, or plant in which distribution and manufacturing
activities occur. In some systems, this is called a business unit.

Enter the alphanumeric code that identifies a separate entity within a
business for which you want to track costs. In some systems, this is called a
branch/plant.

Enter the code that represents a specific category code. Category codes are
user-defined codes that you customize to handle the tracking and reporting
requirements of your organization.

Enter a code that identifies a specific organization, fund, or other reporting
entity. The company code must already exist in the FO010 table and must
identify a reporting entity that has a complete balance sheet.

Enter the three-character code that represents the currency of the transaction.
JD Edwards EnterpriseOne provides currency codes that are recognized by
the International Organization for Standardization (ISO). The system stores
currency codes in the FO013 table.

Enter the company number associated with the document. This number, used
in conjunction with the document number, document type, and general ledger
date, uniquely identifies an original document.

If you assign next numbers by company and fiscal year, the system uses the
document company to retrieve the correct next number for that company.
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Document Number

Document Type

Effective Date

Fiscal Period and Fiscal
Year

G/L Date (general ledger
date)

Xviii

If two or more original documents have the same document number and
document type, you can use the document company to display the document
that you want.

Displays a number that identifies the original document, which can be a
voucher, invoice, journal entry, or time sheet, and so on. On entry forms, you
can assign the original document number or the system can assign it through
the Next Numbers program.

Enter the two-character UDC, from UDC table 00/DT, that identifies the
origin and purpose of the transaction, such as a voucher, invoice, journal
entry, or time sheet. JD Edwards EnterpriseOne reserves these prefixes
for the document types indicated:

P: Accounts payable documents.
R: Accounts receivable documents.
T: Time and pay documents.

I: Inventory documents.

O: Purchase order documents.

S: Sales order documents.

Enter the date on which an address, item, transaction, or record becomes
active. The meaning of this field differs, depending on the program. For
example, the effective date can represent any of these dates:

» The date on which a change of address becomes effective.

» The date on which a lease becomes effective.

* The date on which a price becomes effective.

* The date on which the currency exchange rate becomes effective.

» The date on which a tax rate becomes effective.

Enter a number that identifies the general ledger period and year. For many
programs, you can leave these fields blank to use the current fiscal period and
year defined in the Company Names & Number program (P0010).

Enter the date that identifies the financial period to which a transaction will be
posted. The system compares the date that you enter on the transaction to the
fiscal date pattern assigned to the company to retrieve the appropriate fiscal
period number and year, as well as to perform date validations.
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JD Edwards EnterpriseOne Tools
Foundation Preface

This preface discusses Foundation companion documentation.

Foundation Companion Documentation

Additional, essential information describing the setup and design of JD Edwards EnterpriseOne Tools resides
in companion documentation. The companion documentation consists of important topics that apply to the
Foundation tasks, as well as other JD Edwards EnterpriseOne Tools. You should be familiar with the contents
of these companion documentation depending on the application you are using:

» JD Edwards EnterpriseOne Financial Management Solutions Application Fundamentals 8.12 SP1 Guide
» JD Edwards EnterpriseOne Human Capital Management Application Fundamentals 8.12 SP1 Guide
» JD Edwards EnterpriseOne Customer Relationship Management Application Fundamentals 8.12 SP1 Guide
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CHAPTER 1

Getting Started with Tools Foundation

This getting starting chapter about Oracle’s JD Edwards EnterpriseOne Tools discusses:

» JD Edwards EnterpriseOne Tools Foundation Overview

» JD Edwards EnterpriseOne Tools Foundation Implementation

JD Edwards EnterpriseOne Tools Foundation Overview

JD Edwards EnterpriseOne Tools software provides a flexible, configurable solution in the face of constantly
changing technology and enterprise practices. JD Edwards EnterpriseOne software is the first network-centric
software that separates business rules from the underlying technology. As new technologies emerge, JD
Edwards EnterpriseOne software enables you to easily add them to the framework of your enterprise.

JD Edwards EnterpriseOne Tools Foundation Implementation

This section provides an overview of what you need implemented to complete Foundation tasks.

In the planning phase of your implementation, take advantage of all of Oracle’s sources of information
regarding JD Edwards software, including the installation guides and troubleshooting information. A complete
list of these resources appears in the preface in About This Documentation with information about where to
find the most current version of each.

You might also want to complete at least one JD Edwards introductory training course, if applicable. You
should be familiar with navigating the system and adding, updating, and deleting information by using JD
Edwards menus, and pages, forms, or windows. You should also be comfortable using the World Wide Web
and the Microsoft Windows graphical user interface.
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CHAPTER 2

Understanding JD Edwards EnterpriseOne
Software

This chapter discusses:

» JD Edwards EnterpriseOne access.
» JD Edwards EnterpriseOne software features.
» JD Edwards EnterpriseOne system integration.

» JD Edwards EnterpriseOne foundation.

JD Edwards EnterpriseOne Access

JD Edwards EnterpriseOne supports web client users through the EnterpriseOne Menu. EnterpriseOne Menu
is an HTML-based menu system that provides the ability to navigate EnterpriseOne Menus and launch

an HTML version of JD Edwards EnterpriseOne. EnterpriseOne Menu is used primarily by end users to
conduct end user tasks.

JD Edwards EnterpriseOne Software Features

JD Edwards EnterpriseOne software offers the following features:

* Multiplatform computing. JD Edwards EnterpriseOne software has the ability to run on different platforms.
This versatility allows for easy maintenance of information across a network.

* Integrated supply chain. JD Edwards EnterpriseOne software provides the ability to use the internet and an
intranet to enable you to communicate and share information with your employees, customers, and suppliers.

* Interoperability. JD Edwards EnterpriseOne software lets you leverage your existing investments in
hardware, databases, and software, and integrate them with legacy and third-party products.

» Adaptability. JD Edwards EnterpriseOne software adapts easily to different languages, currencies, reporting
provisions, and technology standards.

» Usability. JD Edwards EnterpriseOne software lets you point and click, drag and drop, and use
fill-in-the-blank forms to easily complete your tasks.

Through the JD Edwards EnterpriseOne Portal, users access JD Edwards EnterpriseOne applications using
links in the Portal’s menus.

The following browsers are supported by JD Edwards EnterpriseOne:
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e Safari on Mac OS
* Mozilla on Linux

* Internet Explorer on Windows

JD Edwards EnterpriseOne System Integration

JD Edwards EnterpriseOne software combines enterprise applications with an integrated toolset to tailor
those applications to the needs of your business.

JD Edwards EnterpriseOne refers to each group of its software products as an application suite. The
application suites support manufacturing, financials, distribution or logistics, and human resource operations
for multisite and multinational organizations. Your business needs determine what application suites are
installed for your enterprise system. For complex business situations, you might use several application
suites to achieve a comprehensive solution.

Each application suite is made up of systems. For example, the Financial Suite contains systems such as
Enhanced Accounts Receivable, system 03B; Accounts Payable, system 04; General Accounting, system 09;
Fixed Assets, system 12; and others. Each system consists of applications, forms, reports, and database tables
that are designed to handle specific business needs.

Because the functions and features of all the systems are similar and integrated, you are not necessarily aware
of moving from one system to another when working with various applications.

This guide often refers to Address Book, system 01, to illustrate the foundational concepts of JD Edwards
software. Address Book, an online version of a traditional card file, is a database of names, addresses, and
phone numbers that:

* Provides easy access to all addresses for searching and reporting purposes
* Reduces the need for duplication of records
* Provides security through Business Unit assignment or Search Type authorization

* Interfaces with other JD Edwards software systems

Because it is fundamental to business solutions, Address Book provides a realistic subject for learning the
foundational concepts of JD Edwards EnterpriseOne software. Many of the tasks that you perform use
Address Book examples.

JD Edwards EnterpriseOne Foundation

The Foundation Guide introduces you to the integrated environment of JD Edwards EnterpriseOne. Through
overviews, procedures, and examples, Foundation describes the operations and functions that are common to
all applications. Foundation comprises the following topics:
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Topic

Description

JD Edwards EnterpriseOne Access

Learn about the different applications that can be used as an
entry point for accessing JD Edwards EnterpriseOne tools
and applications.

Application User Interface

Learn about the operating environment, including menus,
forms, and the grid.

Records

Learn how to locate, add, and work with database records,
add objects, and format and move around on a record-entry
form.

Messages and Queues

Learn to use Work Center to send and work with messages
from JD Edwards EnterpriseOne users and recipients
outside of the JD Edwards EnterpriseOne software
environment.

Media Object Attachments

Learn how to attach objects (text, images, OLE objects, and
JD Edwards EnterpriseOne shortcuts) to rows and forms.

MailMerge Workbench

Learn about merging JD Edwards EnterpriseOne system
records with third-party word processing documents

for automatic creation of form letters by using certain
application workflows.

Interactive Versions for Applications

Learn to modify the behavior of applications through
changes to processing options and interactive version
detail.

Batch Versions for Reports

Learn how to create, modify, and print your own report
versions.

Processing Options

Learn key functionality, types, and how to access and use
processing options.
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CHAPTER 3

Using the JD Edwards EnterpriseOne Web
Application User Interface

This chapter provides an overview of the web application user interface, and discusses how to:
» Access the JD Edwards EnterpriseOne web client.
* Use EnterpriseOne Menu.

» View the Data in Tables and Business Views.

Understanding Web Application Forms

This section discusses web application forms.

Form Types

Applications use a variety of form types. The characteristics of each form type remain the same, regardless
of the application in which you access the form.

Find/Browse Form

The Find/Browse form provides the entry point to most applications. It contains an optional query-by-example
(QBE) line so that you can search any field in the grid. The standard title for a Find/Browse form begins
with "Work With" followed by information that is specific to the business task. You cannot add or change
existing records on a Find/Browse form.

Find/Browse forms enable you to do these tasks:

* Search, view, and select multiple records in a grid

+ Exit to another form to add, change, or view a record
Search/Select Form

Use the Search/Select form to locate a value for a field. The grid displays values that are stored in a database
table. When you select a value from the grid and click the Select button, that value is automatically placed

in the field. For example, when you need to enter a user defined code (UDC) into a field, the search button
appears, enabling you to access a Search/Select form that displays a list of UDCs. You can select an item from
the list and place it in the appropriate field. You cannot edit the information that appears on this form.
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Header Detail and Headerless Detail Forms

The Header Detail and Headerless Detail forms include a detail area, the OK button, and the Cancel button.
You can change multiple records using these forms. The Header Detail form includes information from two
different business views to provide more depth on the information that appears on the form. The Headerless
Detail form provides information from only one table. Data that is common to all the records in the grid
displays at the top of the form.

Header Detail and Headerless Detail forms enable you to:
* Display multiple records

* View records

* Add records

* Change records

* Delete records

Fix/Inspect Form

The Fix/Inspect form does not include a detail area. If a record was chosen on a previous form, the Fix/Inspect
form displays data for that record. If you are adding a record, the Fix/Inspect form is empty, except for
any default values.

Fix/Inspect forms enable you to:

* View a single record
* Add a record

* Change a record

Parent/Child Form

The Parent/Child form presents parent/child relationships in an application on one form. The left portion of the
form presents a list of items. The right portion of the form displays information that relates to the selected item
in the left portion of the form. The Parent/Child form supports the ability to drag and drop items from one area
to another. This form includes Select and Close buttons.

You can resize the display areas according to your personal preferences.

Message Box

The message box contains information about processing that occurs when you work with JD Edwards
EnterpriseOne software. For example, when you delete a record, a Confirm Delete message box appears to ask
if you are sure that you want to delete the object. The message box might also include information about an
event that occurs while you work with the system.

Power Forms

Power forms are web-only application forms that enable you to view multiple, interrelated views of data, grids,
and tab pages on one form and to pass logic between them. The tab pages can have their own business

views (BVs), and these BVs can communicate with each other and can update based on data selection and
changes that occur in other BVs on the form.
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Accessing JD Edwards EnterpriseOne Web Client

This section provides an overview of accessing the JD Edwards EnterpriseOne web client and discusses how to:

» Access the JD Edwards EnterpriseOne Web Client through the JD Edwards Collaborative Portal.
» Accessing the JD Edwards EnterpriseOne Web Client through the through the Enterprise Portal.
» Access the JD Edwards EnterpriseOne Web Client Directly.

Understanding JD Edwards EnterpriseOne Web Client Access

Accessing JD Edwards EnterpriseOne applications on the web is similar to accessing files and applications on
a company network. Typically, either when you start your computer or when you want to access company
network directories, you must sign in to identify yourself to the system as an employee who has the right to
access company resources. After you sign in, you can access files and applications on the network. Similarly,
you must sign in the Web client-the gateway through which you access JD Edwards EnterpriseOne-before you
can launch JD Edwards EnterpriseOne applications.

To sign in to the JD Edwards EnterpriseOne web client, your computer must have access to your company’s
intranet, you must have a Web browser installed on your computer, and your system administrator must
create an account for you. When your system administrator sets up your account, he or she creates a user ID
and assigns you a password.

Usually, you must enter your ID and password when you launch the JD Edwards EnterpriseOne web client.
However, your system administrator can configure your computer in such a way so that you appear to bypass
the sign-in process. For security reasons, however, most system administrators want you to sign in manually.
When you sign in to the JD Edwards EnterpriseOne web client, EnterpriseOne Menu appears. EnterpriseOne
Menu enables you to access JD Edwards EnterpriseOne applications, reports, and other features.

Accessing the JD Edwards EnterpriseOne Web Client
through the JD Edwards Collaborative Portal

When you sign in to the Collaborative Portal, the Portal can pass your sign-in information to JD Edwards
EnterpriseOne. Therefore, all you must do is bring up a workspace containing the EnterpriseOne Menu
portlet. The EnterpriseOne Menu portlet enables you to access JD Edwards EnterpriseOne applications,
reports, and other features.

Accessing the JD Edwards EnterpriseOne Web Client
through the through the Enterprise Portal

When you sign in to the Enterprise Portal, the Portal can pass your sign-in information to JD Edwards
EnterpriseOne. To access specific JD Edwards EnterpriseOne applications, reports, or features, your system
administrator must provide you with specific menu options. Choose a menu option to launch a specific JD
Edwards EnterpriseOne object.

Accessing the JD Edwards EnterpriseOne Web Client Directly
To sign in to the JD Edwards EnterpriseOne web client directly:
Follow this task to sign in to the JD Edwards EnterpriseOne web client if you do not use a portal.

1. Launch your Web browser and navigate to your company’s JD Edwards EnterpriseOne Web sign-in.
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Depending on how your system administrator has configured your system, the Web sign-in might appear
when you launch your browser, you might need to click a button or a link, or you might need to navigate to
a particular page. Your ability to access the JD Edwards EnterpriseOne Web Client directly might have
been disabled. If you do not know how to find the JD Edwards EnterpriseOne Web sign-in, contact your
system administrator.

2. Complete the following fields:
* User ID
» Password

3. If your system administrator indicated that you must sign in to a particular environment, click Details
and complete the Environment field.

4. If you have multiple roles and wish to sign in as one of them, click theDetails button and complete the
Role field.

Note. The default value is *ALL, which signs you in as a member of all of your roles. Select the *ALL
role if you are not sure which role to use.

5. If you want your computer to remember your settings for the future, select Remember my sign in
information.

Note. Do not use this option if other people have access to your computer.

6. Click Sign In.
The EnterpriseOne Menu appears.

Navigating in EnterpriseOne

This section provides an overview of the EnterpriseOne Menu, and discusses how to:

* Navigate in EnterpriseOne Menu.
» Use the fast path.
» Access your favorites task view.

» Add a Task to your Favorites Task View

Understanding EnterpriseOne Navigation
EnterpriseOne Menu is the Web-based application you run to access JD Edwards EnterpriseOne applications.
Menu

The left portion of EnterpriseOne Menu displays a tree structure that you can use to navigate to the specific
application or report that you want to launch. The tree can contain objects other than applications; for this
reason, all objects in the tree are called tasks. Nodes, applications (including reports), and shortcuts in the tree
are all tasks. Each time you click a node, you expand the tree a level and the view of the tree changes.
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Principal sets of tasks are called task views. Your system administrator configures your task view list; that is,
the initial contents of the tree. The list might start or end with a special task view called Favorites. All your
other task views appear above or below this one.

System administrators use JD Edwards Solution Explorer and JD Edwards EnterpriseOne ERP security
applications to manage user accounts and to configure EnterpriseOne Menu.

Fast Path

Fast Path is a field that enables you to access a specific task (that is, a folder, application, or report) directly.
You use commands in Fast Path to move quickly among menus and applications. To use the Fast Path

field, enter a Fast Path code and click the button to the right of the field. Depending on how your system
administrator configured your account, you might not be able to see Fast Path. You can also use the Fast Path
field to access menus. Task views are composed of menus and individual tasks. Menus have no special format
in EnterpriseOne Menu; they simply provide application developers with a convenient method of grouping
applications. When you access a menu, you actually access a specific place in a task view. To access a menu,
enter its ID. For example, GO accesses the Foundation Systems menu. You can find a menu’s ID by hovering
over it.To launch an application, enter the application’s program number. To specify a form in the application,
enter the application’s program number followed by a |, and then enter the form ID. For example, when you
enter PO1012|W01012B, the system displays the Work with Addresses form in the Address Book application.
You can specify a version of a form to open by adding a | and the version number after the form name; for
example, P01012|W01012B|ZJDE0003.Contact your system administrator for specific internal task, menu, and
application IDs. Not all objects have Fast Path commands.

Task View

The Favorites task view is where you can save links to other tasks. If you frequently run a task, you can save
that task in your favorites list. Then, you can access that task directly from your Favorites task view. You
have your own Favorites task view, and other users in your company have their own Favorites task views. No
one else can see your Favorites task view or your changes. Depending on how your system administrator
configured your account, you might not be able to see or change your Favorites task view.

Navigating in EnterpriseOne Menu
Access EnterpriseOne Menu.

1. In EnterpriseOne Menu, click a task (that is, a folder) in the tree.
The task node expands to show the tasks beneath it.
2. Continue to drill into the tree structure until you reach the object you want to launch.

Hover over a task to see more information about it. The system tells you what kind of object the task is (for
example, application, report, and so on) and other information, such as its number and version.

3. To launch the object, click it.

You can launch multiple applications. Depending on how your system administrator has configured your
system, additional applications launch in the same window or in a different window. Either way, the
applications you have running appear at the top of the tree under Open Applications.

4. If you have multiple applications open, click the application name under Open Applications to bring a
specific application to the forefront.

Depending on the object type, you might be able to select a version or to set data selection or processing
options. Click the triangle to the right of the object and make a choice from the resulting drop-down menu.

Copyright © 2006, Oracle. All rights reserved. 11



Using the JD Edwards EnterpriseOne Web Application User Interface

Accessing your Favorites Task View

To access your Favorites task view:

In EnterpriseOne Menu, click the Favoritestask.

Adding a Task to your Favorites Task View

Access EnterpriseOne Menu.

To add a task to your Favorites task view:

L.

In EnterpriseOne Menu, navigate to the task that you want to add to your Favorites task view.

2. Click the arrow next to the task and select Add To Favorites from the resulting menu.

Chapter 3

Using the Grid

This section provides an overview of the grid and discusses:

Create a Grid Format.

Create a Grid Format for Pervasive Devices.
Apply a Grid Format.

Change a Grid Format.

Delete a Grid Format.

Hide or Showing Grid Columns.

Rearrange Grid Columns.

Set Grid Color and Font.

Change Grid Column Width.

Change the Sort Sequence of a Grid.
Exporting All Records from a Grid
Exporting Detail Area Content to Microsoft Excel, Word or to a Comma Separated Values File

Understanding the Grid

Similar to find/browse forms, hierarchical grids, or parent/child browse forms, are used to query business views
(BVs) and select records from BVs for operations. However, instead of a default grid control, hierarchical
grids contain a default parent child control instead. Whether or not you have hierarchical grids depends on if
your system administrator incorporated them into the applications you use.

The following table describes the features of the hierarchical grid:

12
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Feature

Description

Cut, Copy, and Paste

You can cut, copy, and paste a node in the tree. Cutting a node will copy the
data of a node and mark the node as being cut. Copy will copy the data of a
node. Paste will paste the node as the last child of the new node. If the node
is copied, the original node stays. If a node has been cut, the original node is
removed. Cancel Cut will cancel the operation. Use the copy, cut, and paste
buttons located on the toolbar of the grid to perform these functions.

Indent/Outdent You can change the indentation of a tree node. Use the Indent and Outdent
buttons located on the toolbar of the grid to perform these functions.

Expand All You can expand all the nodes in the tree. Use the Expand All button located on
the toolbar of the grid to perform this function.

Collapse All You can collapse all the nodes in the tree. Use the Collapse All button located

on the toolbar of the grid to perform this function.

Fully Expand One Tree Node

You can fully expand a selected tree node. When this happens, all cascading
children of the selected tree node will be displayed. Use the Expand All button
to perform this function.

View Location Number If your system administrator has turned on the View Location Number option,
you will see a number beside each tree node. Use this number to determine the
location of the tree node within the tree.

Flat Display Tree You can make all tree nodes display on one vertical level. Child nodes will not
be indented.

Select All Children You can select all of the children in a node. Use the Select All button located on
the toolbar of the grid to perform this function.

Editable Parent Child You can edit the tree column and all the grid columns in the hierarchical grid.

Change Data Dictionary Item on the
Fly

You can display custom selected columns in a user defined sequence.

Vertical Scrolling Keeps Column
Header

When scrolling down grid data, grid column header will remain visible.

Understanding Grid Icons and Buttons

This table shows the icons and buttons that might display on the grid. Whether or not you see any of these
icons or buttons depends on if the application you are using was designed to display them. You might see a
variation of these icons and buttons, depending on the application in which you are working.

f Delete

Edit

4
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Lock

Unlock

Move Up

Move Down

Price

Print

Attach

Copy

View

Toggle Off

Toggle On
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Sk

Creating a Grid Format

Your ability to create a grid format depends on whether or not your system administrator has enabled the
Customize Grid option. If you do not see the Customize Grid option in the blue bar located at the top of the
grid, you do not have permissions to customize the grid.

Weigh

If you want to recall the default format, save the original grid format before you save a new format. Otherwise,
you must remove the new format, exit the application, and then access the application again to view the
default grid format.

Access the application for which you want to create a new grid.

Launch the application for which you want to create a new grid format and click theCustomize Gridlink.
On Select Grid Format, click the Create button.

Enter a name for the format in the Grid Format Name field.

Complete the rest of the options as desired, and click theOK button.

Click the Close button.

wok W=

Creating a Grid Format for Pervasive Devices
Access the JD Edwards EnterpriseOne web client.

1. Using the JD Edwards EnterpriseOne web client, launch the application for which you want to create
a grid format for pervasive devices.

2. Click Customize Grid and select the format that you want to use for pervasive devices.

If you have not created the format, do so now. Follow the same steps for creating the format that you use
for creating a Web-based format. However, keep in mind the limited space and color options offered by
most pervasive devices when you decide about columns to display, column widths, column and text
colors, and so forth.

3. Click Default for Mobile Device and click Close.

Applying a Grid Format
Access a form with a grid.
On any form with a grid, select a grid format from the drop-down list next to Customize Grid.

You must create one or more grid formats before you can apply a grid format.

Changing a Grid Format

Your ability to change a grid format depends on whether or not your system administrator has enabled the
Customize Grid option. If you do not see the Customize Grid option in the blue bar located at the top of the
grid, you do not have permissions to customize the grid.

Access the application containing the grid format that you want to change.
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Click the Customize Gridlink.

On Select Grid Format, select the grid format that you want to change and click theModify button.
To change the name of the grid format, enter a new name in the Grid Format Name field.

Change other elements of the grid as desired and click the OK button.

Click the Close button.

wok wh =

Deleting a Grid Format

Your ability to delete a grid format depends on whether or not your system administrator has enabled the
Customize Grid option. If you do not see the Customize Grid option in the blue bar located at the top of the
grid, you do not have permissions to customize the grid.

Access a form with a grid.
1. On any form with a grid, click theCustomize Grid link.
2. On Select Grid Format, select the grid format that you want to delete and click the Delete button.

The grid format disappears from the list.
3. Click the Close button.

Hiding or Showing Grid Columns
Access the application containing the grid you want to change.

1. Click theCustomize Grid link and either create a new format or select an existing one to modify.
2. On Customize Grid, scroll to the Display and Order section.

To prevent a column from showing on the grid, select it in the Display and Order list, and then click the
left arrow.

4. To make a column appear on the grid, select it in the Available Columns list, and then click the right arrow.
5. Use the up and down arrows to change the order in which the system displays the columns on the grid.
6. When finished, click the OK button, and then click the Closebutton.

Rearranging Grid Columns
Access the application containing the grid you want to change.

1. Click the Customize Grid link and either create a new format or select an existing one to modify.
2. On Customize Grid, scroll to the Display and Order section.

3. In the Display and Order list, click a column name and use the up and down arrows to move it up or
down in the list.

The system displays the columns in the list in the order in which they appear from top to bottom. In
other words, the column at the top of the list appears first on the grid, the column second from the top
appears second on the grid, and so forth.

4. Repeat step 4 for any other columns that you want to move.

5. When finished, click the OK button, and then click Close.
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Setting Grid Color and Font

Access the application containing the grid that you want to change.

1.
2.

Click the Customize Grid link and either create a new format or select an existing one to modify.
On Customize Grid, scroll to the Display and Order section.

Click a column name in the Display and Order list.

The column name appears in the Selected Column field.

To apply a background color to the column, click a color in the pallet under Column Color.

The hexadecimal value for the color that you chose appears in the Column Color field.

To apply a color to the text in the column, click a color in the pallet under Text Color.

The hexadecimal value for the color that you chose appears in the Text Color field.

To apply a font style such as bold or italics to the text in the column, click the styles that you want to
apply in the Text Options list.

Click the Update Style button.

The system updates the Selected Column field to show you how your choices will look. The system also
places a plus sign next to the column name in the Display and Order list. This symbol indicates that
user-defined formatting will be applied to the column.

Repeat steps 4-8 to apply formatting to additional columns in the grid.
When finished, click the OK button, and then click theClose button.

Changing Grid Column Width

Access the application containing the grid that you want to change.

1.
2.
3.

Click the Customize Grid link and either create a new format or select an existing one to modify.
On Customize Grid, scroll to the Display and Order section.

Click a column name in the Display and Order list.

The column name appears in the Selected Column field.

Enter a percentage value in the % Column Width field.

This value is the percentage of the space that you want the system to allot to the column based on the width

defined for the data item on which the column is based. You can enter a value between 25 and 400.
When finished, click the OK button, and then click theClose button.

Changing the Sort Sequence of a Grid

Access the application containing the grid that you want to change.

1.
2.

Click the Customize Grid link and either create a new format or select an existing one to modify.
On Customize Grid, scroll to the Data Sequencing section.

If you want to sort on a column, click the column name in the Available Columns list, and then click
the right arrow.

The system moves the column name from the Available Columns list to the Sequenced Columns list.
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7.

A column must be included in the grid-that is, its name must appear in the Display and Order list-before
you can sort on it.

If you do not want to sort on a column, click the column name in the Sequenced Columns list, and then
click the left arrow.

The system moves the column name from the Sequenced Columns list to the Available Columns list.

To rearrange the order of sort precedence, use the up and down arrows under the Sequenced Columns list
to rearrange the column names.

The system first sorts by the column at the top of the list, then by the column second from the top, and so
forth.

To sort column values in ascending order, click the column name in the Sequenced Columns list and
select theAscending check box.

If you leave the Ascending box blank, the system sorts the column in descending order.

An A appears next to the column names to be sorted in ascending order, and a D appears next to the
column names to be sorted in descending order.

When finished, click theOK button, and then click the Close button.

Exporting All Records from a Grid

You can export all records from a grid, rather than choosing a range of records to export.

1.
2.
3.

Launch an application with a detail area, and then click the Find button to load the detail area with records.
Click the Tools icon, and then click the Export Grid Data menu.
On Export Assistant, select one of these options:

» Export To Excel

Note. If you select this option, select if you want to export to a new workbook, or an existing workbook.

» Export To Word

» Export To Comma Separated Values (CSV) File character encoding
Select the Export All option.

Click Continue.

Exporting Detail Area Content to Microsoft Excel, Word
or to a Comma Separated Values File

Access an application with a grid.

1.
2.

Launch an application with a grid, and then use Find to load the detail area with records.
From the Tools menu, click Export Grid Data.
On Export Assistant, select one of these options:
» Export to Excel
If you select this option, select if you want to export the data to a new workbook, or an existing workbook.

» Export to Word
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» Export to Comma Separated Values

4. Select Export All to export all the data in the grid, or clear the Export All check box to export a range cells
within the grid containing data that you want to export.

If you clear the Export All check box, then you must select on the grid the range of cells you want to export.
First, click the cell where you want the range to begin, then click the cell where you want the range to end.

If you click the wrong cell, click Reset Selection.
5. Click Continue.
The system exports the detail area contents that you selected to the appropriate file type and displays it.

Working with Interface Features

The section provides an overview of interface features and discusses how to:

* Use Online Documentation
» Work with Error Messages and Error Dialog Boxes

* Turn Auto Populate On or Off

Understanding Interface Features

EnterpriseOne contains features that you use to globally impact the EnterpriseOne web client interface.

Error Messages and Error Dialog Boxes

When you enter information into a field that is inaccurate or unrecognizable by JD Edwards EnterpriseOne, or
if you fail to enter data into a required field, the field displays a red background to indicate the error, and an
error message displays at the top of the form. If there are multiple errors on one form, they will display as a list
at the top of the form. You can view more information about the error by clicking the arrow located to the left
of the error message. If the error message has a Go To Error link to the right of it, you can click the link and JD
Edwards EnterpriseOne will place your cursor in the field that correlates to the error message.

When you place your cursor in a field that contains an error, a dialog box displays that further identifies what
you must enter into the field to correct the error. You can move the dialog box by clicking the top of it and
dragging it to another location on the screen. The dialog box contains a Validate button that you click to
validate that the information you have entered is accurate and recognizable. You can also tab out of the field to
validate the information. After the information is validated, the error message is removed from the list.

Using the dialog box, you can move to the next and previous fields that contain errors by clicking the left and
right arrows in the dialog box. To view all the errors on the form listed at the top of the form, click Summary.
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Auto Populate On

AutoPopulate assists you when you are performing repetitive data entry on the grid control. It uses content
that already exists in the grid column to populate the cell in which you are currently typing. If the characters
you are typing match those that already exist in the same column, AutoPopulate automatically adds the
whole string of characters from the existing cell to the current cell. For example, you have already entered
the following number into a cell in the column in which you are currently typing: 330456 If you type a 3 in
the current cell, AutoPopulate will automatically place 330456 in the cell in which you are working. You
can opt to accept the number by pressing tab, or you can delete the number and enter one of your own. You
can turn AutoPopulate on or off. The action you select will apply to all applications to which you have
access within JD Edwards EnterpriseOne.

The feature is disabled for simplified Chinese, Korean, Japanese, and traditional Chinese language
environments.

Using Online Documentation

Some tasks have documentation associated with them that you can view for information about how to perform
a task.

To see the task documentation, click the triangle next to the task and select Documentation from the menu. A
task might have multiple pages of documentation associated with it. If it does, two or more tabs appear at the
top of the documentation frame. Click the different tabs to see all the documentation.

You access field-level help by placing the cursor is in a field and pressing F1 or by clicking the Item Help icon
located at the top-right corner of a form. If the field in which the cursor resides is a business view column, the
system displays the alias name, business view name and description, table name and description, and glossary
text. If the field in which your cursor resides is a data dictionary column, the system displays the alias name,
the term Data Dictionary Item, and the glossary text.

Working with Error Messages and Error Dialog Boxes
To view error messages and correct errors:

1. On the application on which you are working, if there are red fields indicating errors, scroll to the top of the
form and review the error messages that are displayed.

2. If the error messages you are viewing contains a Go to Error link, click the link to go to the field that
correlates to the error message.

Enter valid information into the field.

4. Click the Validate button, or tab out of the field, to ensure that the information you entered is correct or
recognizable. If it is, the dialog box disappears, the field displays a white background, and the error
message is removed from the list.

Turning Auto Populate On or Off

To turn Auto Populate On or Off, from the Tools menu, click AutoPopulate. If a check mark displays beside
AutoPopulate, the feature is turned on. If no check mark displays, it is turned off.
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Using JD Edwards Web Applications and Reports

This chapter provides an overview of web applications and reports and discusses how to:

» Launch an application or report.

» Launch applications in separate windows
» Send a shortcut to an application form

» Use Web application forms.

* Use detail area.

* Recover data.

¢ Work with search criteria

Note. If you are not using Internet Explorer as your browser, you might not have access to some of the functionality
mentioned in this chapter.

Launching Applications and Reports
This section provides an overview of how to launch an application or report and discusses how to:
» Launch an application or report.
» Launch Applications in Separate Windows

* Send a Shortcut to an application form.

Understanding How to Launch an Application or Report

JD Edwards provides a variety of applications, reports, and other objects. Typically, you access these objects
from the EnterpriseOne Menu.

Launching an Application or Report
Access EnterpriseOne Menu.

1. In EnterpriseOne Menu, navigate to the application or report you want to launch.

2. To launch the application or report without defining processing options, version, and so forth, double-click
the report or application.

Applications launch immediately. If you launch a report the system launches Work with Batch Versions
so you can select which version you want to run.

3. To select processing options or version for an application, click the arrow next to the task and select
Values or Versions, respectively.
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After you select the processing options or version, the system launches the application. Depending on how
your system administrator configured the system, the application launches either in the existing window or
in a new one. Either way, you can run multiple applications simultaneously. All applications you have
running are listed in the EnterpriseOne Menu toward the top, under Open Applications. You can switch
among them by clicking the application you want in the list.

To select processing options or version or to designate data selection parameters for a report, click the
arrow next to the task and select one of these options:

* Values

* Versions

* Data Selection

* Data Selection & Values

After you set the options, the system might launch Work with Batch Versions so you can select which
version you want to run. Then, Version Prompting appears. Select the prompting you want and click
Submit to select a printer and process the report.

Launching Applications in Separate Windows

When you open more than one application, you can select to have the application launch in the existing
window, or in a new window. If you select to have it launch in the existing window, JD Edwards EnterpriseOne
replaces the application on which you are currently working with the application that you have just launched.
If you select to launch additional applications in new windows, then each application appears and is fully
functional in its own window. Each open application is listed in the menu area of each window.

To launch applications in new windows:

1.
2.

Open an application.
Click New Window on the menu area.

A new browser window will be opened, which also contains the menu area. You can launch any application
in this new browser window.

Viewing Report Output

Access EnterpriseOne Menu.

Before you can view the output of your reports online, you must run a report version.

AN A e

In EnterpriseOne Menu, click My System Options.

On User Default Revisions, click Submitted Reports.

On Work with Servers, select the server on which the report was run.
Click Select.

On Submitted Job Search, select the report you want to view.

From the Row menu, click View PDF.

The report displays in read-only, PDF format.

To view report data on pages other than the one currently displayed, type a page number in the field
located at the bottom of the PDF viewer.
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JD Edwards EnterpriseOne contains a feature called Page at a Time PDF that assists in downloading large
files quickly. If your system administrator has enabled this feature, you should immediately see the first
page of the PDF file. If Page at a Time is not enabled, you will see a blank screen in the PDF viewer while
the file downloads. If this is the case, contact your system administrator.

Changing your Password

Access EnterpriseOne Menu.

1.
2.
3.

In EnterpriseOne Menu, click User Options.

On User Default Revisions, click Change Password.

On User Password Revisions, complete the following fields and click OK:
* Old Password

* New Password

* New Password - Verify

Sending a Shortcut to an Application Form

While you are working in the JD Edwards EnterpriseOne web client, you can email other users a shortcut to
the application and form that you are looking at. The recipient double-clicks the shortcut in the email to access
your current position in the software.

To send a shortcut to an application form:

1.
2.

Launch a Web application and access the form that you want to send.
Click Tools and select Send Shortcut.

On Send Shortcut, complete these fields:

* Address Number / User / Role / Distribution List

Note. If you are sending a shortcut to members of a distribution list, you must click the Distribution List
option and then select the address book number of the distribution list. If you enter the distribution-list
address-book number without choosing the Distribution List option, the shortcut will be sent only to the
distribution-list address-book number and not to the members of the distribution list.

* Mail Box
Select which mailbox/queue you want the message to be sent to.
* Subject
Type the text that you want to appear in the Subject line of the email message.
If you want to include a message with the shortcut, type it in the large field at the bottom of the form.
Click OK to send the shortcut.

The recipient will receive the shortcut using an email in the Work Center or a third-party email system,
depending on the recipient’s email preferences in JD Edwards EnterpriseOne.
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Working with Search Criteria
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This section provides an overview of search criteria and discusses how to:

¢ Save search criteria
* Apply saved search criteria
« Edit search criteria

* Delete search criteria

Understanding Search Criteria

You can create search criteria using the QBE and wildcard features, then save that criteria for use later.
Save search criteria that you use often to find records. Your ability to save search criteria depends on how
the application has been designed. The search criteria that you save is available to you only; no other user
can access it.

After you have saved search criteria using the Save Query option, you can apply the criteria to your current
search.

Saving Search Criteria
Access a form that contains the Save Query option.

1. Enter your search criteria in the fields and then click Save Query.
2. On Save Query, in the Saved Query Name field, type a name for the saved search criteria.

Click the More Options link to enter more search criteria to further narrow your search. The information
that is listed as more options is determined by how the application has been designed.

4. Click Save.

Applying Saved Search Criteria
To apply criteria to your current search:

1. Access the form where you saved your search criteria.
2. From the Select a Query field, select the query that contains the search criteria you want to apply.

JD Edwards EnterpriseOne applies the search criteria to the current form.

Editing Search Criteria

Access the form where you saved your search criteria.

1. Click Edit Queries.
2. Select the query you want to edit.

3. Edit the information.

Deleting Search Criteria

Access the form where you saved your search criteria.

Copyright © 2006, Oracle. All rights reserved.



Chapter 4 Using JD Edwards Web Applications and Reports

1. Click Edit Queries.
2. Select the query you want delete, and click Delete.

Viewing the Data in Tables and Business Views

The section provides an overview of Data Browser and discusses how to:

¢ Access Data Browser.
» Search for data in tables.
» Search for data in business views.

» Use existing queries to search for data in tables and business views.

Understanding Data Browser

If you want to view the data in tables and business views, you can use Data Browser. This tool enables you
to verify the existence of data in a table or business view, as well as to determine the table or business view
structure. This section provides an overview about the EnterpriseOne Menu, and discusses how to:

* Access Data Browser.

 Use existing queries to search for data.
* Search for data in tables.

* Search for data in business views.

* Create personal search queries for data in tables and business views.

Accessing Data Browser

Type databrowser in the Fast Path. If you type databrowser in the Fast Path, the Query Selector form displays.
If you are in an application, you can access the Data Browser by clicking the Tools menu, and then clicking
Data Browser. If you access the Data Browser from an application, the Query Selector and the Data Browser
forms display. The Query Selector form enables you to select queries, tables, or business views to search for
data. The Data Browser form enables you to search for data for a specific table or business view. When you
access Data Browser from an application, the only tables and business views on which you can search are
those that correspond to the application you are in.

Searching for Data in Tables
Access the Data Browser.
1. Type databrowser in the Fast Path.

2. Select the By Table option.

In the Name field located under the By Table option, type the name of the table on which you want to
search, or use the search button to locate a table.

4. Press Tab.

The Data Source field automatically displays the name of the data source in which the table resides for the
environment in which you are currently logged.
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5. In the Data Source field, if the data source that is displayed is different than the one from which you want
to search, type a new data source, or use the search button to locate a data source.

6. Click OK.

Searching for Data in Business Views
Access the Data Browser.

1. Type databrowser in the Fast Path.
2. Select the By Business View option.

3. In the Name field, type the name of the business view on which you want to search, or use the search
button to locate a business view.

4. Click OK.

Using Existing Queries to Search for Data in Tables
and Business Views

Access the Data Browser.

1. Select the Personal Queries or Public Queries option.

The Personal Queries option enables you to select from a drop-down menu queries you have created for
yourself. The Public Queries option enables you to choose from a drop-down menu queries that have been
made available to you by a system administrator.

2. From the drop-down menu located next to the option you selected, select the query on which you want
to search.

3. Click OK.

Creating Personal Search Queries to Search for Data
in Tables and Business Views

Access the Data Browser.

Follow the instructions for Searching for Data in Tables or Searching for Data in Business Views.
On Data Browser, enter any filter information you want included in the query.

Click Save Query.

Click Close.

The query is saved and displays in the Personal Queries drop-down menu.

b=

Recovering Data

This section provides an overview of how to recover data and discusses how to:

¢ Retrieve all records from the database

* Voluntarily save data
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» Retrieve data

* View data

Understanding how to Recover Data

You use JD Edwards EnterpriseOne web client to recover data from applications that have erred or timed
out due to:

* Catastrophic errors
» Transaction failures
 Session time outs

* Voluntary save

Data saved from system failures are saved at the time when the system errors, failures, or time outs occur.
The P95400 program (Application Failure Recovery Applications) enables you to access and recover data
from any transaction from which you have saved data. Using P95400, you can view the data from failed
transactions. You must be granted permission by an administrator to view data from applications that are
not your own. For example, an administrator might give a sales department supervisor the permission to
recover data from transactions performed by other users in the department. If you are unable to save data,
check with your system administrator.

Retrieving All Records from the Database

Fetch All Records enables you to retrieve all records from the database that match your search criteria. JD
Edwards EnterpriseOne then categorizes the records into larger groups so that you are able to view several
records by scrolling through the grid, rather than having to view only ten at a time. The default number
of records in a group is 200.

To fetch all records, click the Go to End button located on the blue bar on the grid.

Voluntarily Saving Data

Your ability to save data voluntarily depends on whether or not your system administrator has this feature
enabled or disabled. Access an application in which you have entered data.

1. Click Tools, then select one of these options:
Save
Save As

2. On Select Application Failure Header Label, select the check box if you want the JD Edwards
EnterpriseOne to assign a label to the data you are saving. To manually enter a label and description, clear
the box and enter a label and description in the respective fields.

Note. The label is a name you assign the data, like a filename. The description is a brief explanation
that helps you identify what the data is.

3. Click OK.

JD Edwards EnterpriseOne saves the data you have entered in the application.
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Retrieving Data
Access the P95400 application.

1. On Work with Application Failure Records, search for data using these criteria:

From Saved Date and To Saved Date Type the dates between which the data for which you are searching
was saved.

If you select one of the following options in addition to the dates you have entered in these fields, JD
Edwards EnterpriseOne retrieves the data saved within the dates, and that matches the search criteria
you specify.

View All

Click this option to view all of the data that was saved, including system failures, time outs, or voluntary
saves.

View Failures

Click this option to view only that data that was saved due to system failure.

View Saves

Click this option to view only that data that was saved voluntarily.

View Timeouts

Click this option to view only that data that was saved because the system timed out.
2. Click Find.

JD Edwards EnterpriseOne retrieves the data that matches the search criteria you entered.
3. Click the record that contains the data you want to save.

On Saved Application Data, click the record or records containing the data you want to view.

Note. Each record is a form within the application where data was saved. If no data was saved on the
form, either because it was not saved voluntarily, or because there was no data added to it---as in a
Search/Browse form---you will see an N in the Data Saved (Y/N) column.

Viewing Data
After you have retrieved data, you view the information contained in the records.

1. Retrieve the data you want to view.
2. Select a record from the bottom grid, and then click View Data.

The information contained in the record displays in a read-only format.

Working with Tasks, User Options, and the Calendar

The section discusses how to:

* Filter tasks by role.
 Use task profiles.

» Work with user options.
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» Access the calendar.

Filtering Tasks by Role

Using JD Edwards Web Applications and Reports

You filter the tasks that you see by selecting a role. Each role contains its own set of tasks. When you log
into JD Edwards EnterpriseOne using the *ALL role, you now see only those tasks associated with a single
role rather than a concatenation of all tasks associated with all roles.

In the Web client, you view the other roles assigned to you by choosing the role from the Role drop-down
menu located on EnterpriseOne Menu, and then clicking the button to the right of the field.

The tree view changes to show the tasks that are available to the role that you chose.

Using Task Profiles

For each task, you can view profile information about the task itself. To display the profile for a task, click the

triangle to the right of the task and select Task Profile.

The Task Profiles window has three tabs: Basic, Intermediate, and Advanced. The information in the window
varies based on the item currently selected. Some of the information on the tabs is described below:

» Version resides on the Intermediate tab.

* Object Name resides on the Intermediate tab.

* Task ID resides on the Advanced tab. If you know an object’s task ID, you can launch it directly from

the Fast Path toolbar.

Working with User Options

When you click My System Options, the User Default Revisions form appears. The following list describes
the associated action for each button on the User Default Revisions form:

Button

Description

User Profile Revisions

Launches the User Profile Revisions program (P0092).
Only system administrators should change user profiles.

Change Password

Launches the JD Edwards EnterpriseOne Security program
(P98OWSEC), which you use to change your password.

Submitted Reports

Launches the Work With Servers program (P986116),
which you can use to review the status of a submitted report
or job, change your report or job priority, work with the
report output, and review errors.

View Local Output

Accesses the PrintQueue directory on the machine that is
running JD Edwards EnterpriseOne.

Default Printer

Launches the Printer Application program (P98616).
Only system administrators should change default printer
settings.
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Accessing the Calendar

The calendar enables you to enter and view time sensitive information, such has meetings and appointments.
Depending on the permissions your system administrator has assigned you, you can view, add, delete, and
modify activities listed in the calendar. You can view the calendar one day at a time, by the week, or by the
month. Your system administrator determines the calendar view that you see.

This section discusses the default features and functionality that are available in the calendar. You might not
see some of these features or might not be able to perform some functions due to your permissions. The default
view for the calendar consists of one large calendar on the left with a Day tab, a Week tab, and a Month

tab. Three small calendars are located on the right side. The first small calendar shows the month previous

to the month displayed in the large calendar. The second calendar shows the month displayed in the large
calendar. The third calendar shows the month following the month displayed in the large calendar. Today’s
date is highlighted in a yellow box in the appropriate small calendar.

The large calendar and the three small calendars are fully interactive. Clicking in any calendar automatically
adjusts the other calendars. For example, if you select a week in the large calendar, the week will be selected in
the corresponding small calendar as well.

You can double click in the large calendar to add an activity, if you have appropriate permissions. If you are
adding an activity on the Day tab, double clicking on a time line automatically assigns a 30 minute time slot,
which you can change. Clicking on the time located at the beginning of the line automatically assigns a 1
hour time slot, which you can change as well. If you your calendar displays an activity that exceeds 24 hours,
the activity displays in the All Day row at the top of the large calendar. The calendar automatically adjusts
across time zones. For example, if someone schedules a meeting for 8:00 a.m. Pacific time, the activity

will appear at 10:00 a.m. Central time.

To access the calendar, type P01301 in the Fast Path.
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Understanding Messages and Queues

This chapter provides an overview of messages and queues and discusses:
* Internal and External messages
* Workflow messages

* Queues

Messages and Queues Overview

With JD Edwards EnterpriseOne, you can send and receive electronic mail (email) messages through the
Work Center program. The JD Edwards EnterpriseOne email system includes messages sent by users and
messages sent by a workflow process.

You can organize your messages by placing them into queues (storage areas for your messages) provided by
the software or by setting up your own queues. This section explains how to work with your messages and
with your queues. In addition, you can indicate your work-time location and add remarks to your time log.

Internal and External Messages

JD Edwards EnterpriseOne sends your email messages in different ways, depending upon whether the message
is internal or external to the system.

Internal Messages Internal messages stay within the JD Edwards
EnterpriseOne system. They are read using the Work
Center.

External Messages External messages are sent to third-party email software
packages such as Microsoft Outlook or Lotus Notes.

You system administrator configures your JD Edwards EnterpriseOne user account to receive either internal
or external email. However, certain messages are sent as internal email regardless of this preference; for
example, notifications of submitted UBE jobs.
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Workflow Messages

In addition to sending and receiving internal and external messages, you can receive an active message, which
is a type of message that a system workflow process automatically sends to a recipient.

Active Messages

Workflow processes sometimes generate messages that
require you to take action, such as approving or rejecting
a change to a customer record. A lightning bolt button
identifies an active message.

Active messages contain a shortcut button that links
directly to an application. When you click the shortcut
button, the system retrieves the most current information
from the database, which ensures that you get accurate
information even if changes are made after an active
message is sent to you.

You can set up a workflow process to send active messages
to specific queues.

Queues

Queues are storage areas that enable you to organize messages using the Work Center. For example, messages
can be organized into queues for priority mail or for submitted jobs. Through a queue, users can approve or
reject specific tasks in a workflow process. A queue is actually a UDC, and you set up a queue in the same way

that you would set up a UDC.

Queues Provided with JD Edwards EnterpriseOne

JD Edwards EnterpriseOne provides these queues:

Sent

Messages that you have sent to others.

Deleted

Messages that you have deleted. After you delete a
message, you can view it but you cannot move it to another
queue.

The system administrator has the authority to purge
deleted messages from the system, which is typically done
periodically or on a predetermined schedule. You can also
remove a message from the system by deleting it from your
Deleted queue.

Submitted Jobs

Messages generated by the system for jobs that you have
submitted for batch processing, such as the General Ledger
Post.

32
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Workflow Queues

Workflow includes several predefined queues, but you might want to set up a custom queue for messages
generated by processes that you create. For example, you might want to set up a queue for messages generated
by a credit limit approval process. This queue would gather any approval or rejection messages related to
credit limits for customers. A user could then open that queue and act on the message contained within it.
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Working with Messages

This chapter discusses how to:
* Send messages

* Work with shortcuts

» Use the Work Center

* Print messages

Sending Messages

This section provides an overview of sending messages and discusses how to:
* Send an internal message to a single recipient.
» Use a quick list to send a message to multiple recipients.

» Send a message to members of a role.

Understanding How to Send Messages

When you send internal email messages, you send them to other users within JD Edwards EnterpriseOne
software. You can control the time of delivery for a message by assigning a tickler date to the message. A
tickler date is a date in the future when the system will automatically show the message. Assigning a tickler
date is especially helpful if you plan to be out of the office on the day that you want others to receive your
message, or if you want to remind yourself about upcoming meetings or other obligations.

When you send internal messages, you can also include an attachment. Attachments enable you to include
files, images, or links that conform to the OLE standard, such as word processing documents and spreadsheets.

You can send messages to one or more recipients. If you are sending a message to multiple recipients, you can
use a quick list, a predefined distribution list, or a role.

See Also

Chapter 5. “Understanding Messages and Queues,” page 31
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Forms used to Send an Internal Message to a Single Recipient

Form Name

FormID

Navigation

Usage

Send Internal Message

WO012505A

From any application, click
theTools button, then click
Send Shortcut.

Send a non-workflow
shortcut.

Sending an Internal Message to a Single Recipient

Access any application in JD Edwards EnterpriseOne.

1. From any application, click the down arrow on the hyper-button, select Tools, Send, and then select

Internal Mail.

2. On Send Internal Mail, click the Search button in the "Send To Address Number / User / Role" field.

On Address Number / User / Role, select one of the following options to search for a recipient by address
number or user ID, and then click OK:

e Address Number

e User

4. Highlight the row that contains the recipient and then click Select.

Type the subject of the message in the Subject field.

6. Complete the following optional fields, as necessary:

* Type
* Mail Box
* Marketing
» Lead Source

* Keep Copy

* Receipt Notify

e Address
» Contact
» Tickler Date

* Phone Number

7. Type your message in the text area at the bottom of the form.

To include an attachment with your message, right-click the panel with the Text button.

9. Choose New, and then one of these options:

* Image

* OLE

* Shortcut
» URL/File

10. Click OK to send the message.
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The system returns you to the previous application. If you opt to keep a copy of a message that you send,
you can view it in the same queue from which you sent the message.

Using a Quick List to Send a Message to Multiple Recipients
Access any application in JD Edwards EnterpriseOne.

1. From any application, click the down arrow on the hyper-button, select Tools, select Send, and then
select Internal Mail.

2. On Send Internal Mail, select Quick List from the Form menu.

On Quick List, complete either of the following fields for each person you want on the list, and then
click OK:

» Alpha Name
e Address Number

4. Follow the steps for sending an internal message to a single recipient.

Note. You cannot save a quick list.

Sending a Message to Members of a Role
Access any application in JD Edwards EnterpriseOne.

1. From any application, click the down arrow on the hyper-button, select Tools, select Send, and then
select Internal Mail.

On Send Internal Mail, click the Search button in the "Send To Address Number / User / Role" field.
On Address Number / User / Role, select the Role option, and then click OK.
Highlight the row that contains the role that you want to use and then click Select.

ok »w D

Follow the steps for sending an internal message to a single recipient.

Working with Shortcuts

This section contains an overview of working with shortcuts and discusses how to send a non-workflow
shortcut.

Understanding Shortcuts

With the JD Edwards EnterpriseOne messaging system, you can send messages that contain a shortcut to
a JD Edwards EnterpriseOne application. When you send a shortcut, you can preface it with a message
for the recipient to review and approve. For example, you might want your manager to approve a change
that you made to a customer record. After sending a shortcut to your manager, he or she can view the
record immediately by clicking the shortcut button. When you send a shortcut, the system sends the key
for that particular record to the recipient. When the recipient clicks the shortcut button, the system opens
the application and retrieves the record.
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The JD Edwards EnterpriseOne system uses workflow to automatically send messages with a shortcut to an
application. These types of messages, called active messages, require that the recipient open the shortcut to
verify information or approve a transaction.

Since JD Edwards EnterpriseOne software supports Windows and Web clients, the message can contain a
shortcut for a Windows application or a Web application.

Form Used to Send a Non-Workflow Shortcut

Form Name FormID Navigation Usage
Send Shortcut WO012505A From any application, click | Send a non-workflow
theTools button, then click shortcut.
Send Shortcut.

Sending a Non-Workflow Shortcut

From the application from which you want to create a shortcut, access any records you want the recipient to
view.

1. Click the down arrow on the hyper-button and select Tools, and then Send Shortcut.
The Send Shortcut form appears with a shortcut to the application.
2. On Send Shortcut, complete these fields:
* Address Number / User / Role / Distribution List
* Mail Box (Internal Messages Only)
* Subject
3. Type your message.

4. Click OK to send the message.

Using the Work Center

38

This section provides an overview of the Work Center and discusses how to:
* View messages.

» Revise messages.

* Move a message to another queue.

» Redirecting messages to the Priority or Secondary queue.

 Cancel the delivery of messages.

* Reassign messages.

* Delete messages.

* Print messages.

* Print a report that lists all messages in a queue
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Understanding the Work Center

Use the Work Center to send and receive internal email messages within the JD Edwards EnterpriseOne
system. Work Center enables you to perform standard email functions.

View Messages

You can view your messages in the Work Center. Messages sent from other users will appear in either your
Personal In Basket queue or, if you set them up, your Priority Mail and Secondary queues. You can also view
workflow messages, or active messages, sent by a workflow process.

Note. If you cannot view messages, make sure that queue security is set up to enable you to view the Address
Book number and queue that you want to view.

Revise Messages

You can revise the text of messages in any of your queues. This feature opens up the actual message and
enables you to change the text or add new text.

Move a Message to Another Queue

You can move a message from one queue to another. For example, you might want to move a message from
your Priority queue to your Personal To Do List queue.

Redirect Messages to the Priority or Secondary Queue

You can redirect messages that you receive from an individual to your Priority Mail queue. When you do this,
the system sends all future messages from that individual directly to your Priority Mail queue. Alternatively,
you can redirect messages from an individual to your Secondary queue.

To redirect messages to the Priority Mail or Secondary queue, you must follow these steps and not the ones for
moving messages. Moving messages only moves individual messages, whereas redirecting messages to the
Priority Mail or Secondary queue affects all messages from that user until you remove the designation.

Although you can move a message to the Archived or Deleted queue, the system does not redirect future
messages from the sender to that queue. You must manually move the sender’s message to the Archived
or Deleted queue each time.

You can redirect messages from more than one person to your Priority Mail and Secondary queues. You can
also prevent messages from being delivered to a specific queue.

Cancel the Delivery of Messages

If you decide that you no longer want the system to automatically redirect messages from an individual to a
Priority Mail queue, you can cancel the automatic delivery of messages to your Priority Mail or Secondary
queue.

Reassign Messages

The messaging system enables you to reassign a message to another user after the message is sent to the
original recipient. This process changes whose queue the message appears in. For example, if you originally
sent a message to Jim, you can reassign that message to Betty. The message will now be in Betty’s queue and
will not be in Jim’s queue. You can also reassign messages that you receive.

You can only reassign messages in other users’ queues if your queue security enables.
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Delete Messages

Chapter 6

You cannot recover a message after you move it to the Deleted queue. It remains in your Deleted queue until
your system administrator purges messages, which is typically done on a periodic or predetermined schedule.
Alternatively, you can remove a message from the system by deleting it from your Deleted queue.

Forms Used to Access the Work Center

Form Name FormID Navigation Usage
Employee Work Center - WO012503F In the Fast Path, type G02. Send and receive internal
Work Center email.

Employee Work Center - W012503D On Employee Work Center - | Select the default value you
Address Number / User Work Center, click the search | want displayed when you
/Role button located beside the access Work Center.
Address Number / User /
Role field.
Employee Work Center - WO0101SXA On Employee Work Center - | Search for records by
Address Book Search Address Number / User / address number, users,
Without Private Data Role, click OK. orroles.
Address Book Master Search| W0101SA On Employee Work Center - | Look up address book
Address Book Search numbers.

Without Private Data, select
arecord and click Search.

Viewing Messages

Access any application.

1. Click the down arrow on the hyper-button and select Tools, and then Work Center.

2. On Work Center, expand a queue that contains a message.

Unless the All Queues check box is selected, only those queues that contain mail will display. Any
messages in that queue appear. Messages that have not been viewed appear in bold.

3. Click the message that you want to view.

The message appears in the view area on the right side of the Work Center form.

Revising Messages

Access any application.

1.

2.

3.

4.
* From
* Contact
* Subject

From the Row menu, select Message Revisions.

On Work Center, select the message that you want to revise.

Click the down arrow on the hyper-button, select Tools, and then select Work Center.

On the Message Revisions form, change any of the following fields and then click OK:
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* Phone Number
 Tickler Date

e Text area

Moving a Message to Another Queue
Access any application:

1. Click the down arrow on the hyper-button, select Tools, and then select Work Center.

2. On Work Center, click the All Queues option if the target queue to which you want to move the message
does not appear.

Click and drag the message to the target queue.

4. To verify the placement of the message, double-click the target queue and view the contents.

Redirecting Messages to the Priority or Secondary Queue
Access any application.

1. Click the down arrow on the hyper-button, select Tools, and then select Work Center.
2. On Work Center, select the message that you want to redirect to your Priority Mail or Secondary queue.
3. From the Row menu, select one of these options:
* Priority
» Secondary
4. Expand the target queue to verify the placement of your message.

Any further messages that you receive from this sender will arrive in the queue that you selected. Repeat
these steps for redirecting other users’ messages.

Canceling the Delivery of Messages
Access any application:

Click the down arrow on the hyper-button, select Tools, and then select Work Center.
On Work Center, select a message from the user for which you want to cancel automatic delivery.

From the Row menu, select Remove.

.

Move any other messages from this particular sender out of the Priority Mail or Secondary queue.

As long as you keep any messages in your Priority Mail or Secondary queue from the sender whom you
removed, future messages from that sender will appear in that queue.

Reassigning Messages
Access any application:

1. Click the down arrow on the hyper-button, select Tools, and then select Work Center.

2. On Work Center, select the message that you want to reassign, and then, from the Row menu, select
Reassign.

3. On Assign Message, complete these fields and click OK:
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e Address Number / User / Role

* Queue Designator

Deleting Messages

To delete a message, drag the message to the Deleted queue. Alternatively, select the message and click Delete.

Printing Messages

This section provides an overview of message printing and discusses how to:

42

Print a message.

Print a report that lists all messages in a queue.

Understanding Message Printing

You might find that you want a printed copy of a message for your records. You can do either of these tasks:

Print a message

You can print a message from any of your queues.

Print a report that lists all messages within a queue

This report includes a summary for each message. The two types of message reports are:
Message Center - Summary

Message Center - Detail

These reports show the sender and recipient of the message, as well as the subject of the message. The
detail report shows the content of each message.

Printing a Message

Access any application in JD Edwards EnterpriseOne.

el S

Click the down arrow on the hyper-button, select Tools, and then select Work Center.
On Work Center, select the message that you want to print.
From the Row menu, select Print.

On Printer Selection, click OK.

Printing a Report that Lists All Messages in a Queue

Access any application in JD Edwards EnterpriseOne.

el S

Click the down arrow on the hyper-button, select Tools, and then select Work Center.
On Work Center, select the message queue that you want to print.
From the Form menu, select Print.

On Work with Batch Versions - Available Versions, select the version and submit the report.
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Working with Queues

This chapter provides an overview of working with queues and discusses how to:

» Set up queues.

* Log time and add remarks.

Understanding Queues

Queues are a way to group related messages together in the Work Center. This topic describes how to manage
your queues by creating new ones or adding security. As with a message, you can also add a shortcut to a queue.

You set up queues in the system as UDCs. The following task describes how to create queues or modify
existing queues.

Setting Up Queues
This section discusses how to:
* Set up a queue.
* Specify the queues that a user can view.

* Changing a user’s queue security.

Setting Up a Queue
Access the Work With User Defined Codes form.
1. On Work With User Defined Codes, click Add.
2. On User Defined Codes, complete the following fields in an empty row on the grid and click OK:
* Codes
Enter a unique number for the queue.
* Description 1
Enter a name for the queue.
* Description 2

* Special Handling
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e Hard Coded

Enter N in this field.

Codes
Description 1
Description 2

Special Handling

Hard Coded

Chapter 7

A list of valid codes for a specific user defined code list.
A user defined name or remark.
Additional text that further describes or clarifies a field in the system.

A code that indicates special processing requirements for certain user
defined code values. The value that you enter in this field is unique
for each user defined code type.

The system uses the special handling code in many ways. For example,
special handling codes defined for Language Preference specify whether
the language is double-byte or does not have uppercase characters.
Programming is required to activate this field.

A code that indicates whether a user defined code is hard-coded.
Values are:

Y

The user defined code is hard-coded

N

The user defined code is not hard-coded

A check mark indicates that the user defined code is hard-coded.

Specifying the Queues that a User Can View

You can change the security status for a user or group of users within a queue. You can either give a user
authority to monitor every queue within a group, or you can deny users access to certain queues.

You can add security by user, distribution list, or role. For example, you might want to set up security so that a
manager can monitor all messages within certain queues. Or you might set up security by distribution list or
role so that users within the group have authority to monitor certain queues.

If you want to give only a few people within a distribution list or a role access to certain queues, you enter
the distribution list or the role, and then enter the users’ address book numbers to define which queues those

users in the group can access.

Access the Work With Workflow Message Security form.

1. On Work With Workflow Message Security, click Add.
2. On Workflow Message Security Revisions, complete these fields:

e User

» Group/Role

3. Specify the queues that a user can view by completing the Authority Y/N field and clicking OK.

User

Group/Role

A user in the workflow system. This can also be a group.

A group or list of users in the workflow system. The address book number
that identifies a list of users in the workflow system.
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Authority Y/N Indicates whether the user is authorized to make changes to security
information.

--- FORM SPECIFIC ---

For workflow, indicates whether the user can view other queues in the
Work Center.

Logging Time and Adding Remarks
This section provides an overview of the Work Center monitoring features and discusses how to:

* Check in and out.
» Enter remarks.

* View time logs.

Understanding Work Center Monitoring

The Work Center enables you to inform others of your whereabouts. You can specify when you are in or out of
the office by using the Check In and Check Out options. You can add remarks to your check out to provide
detailed information about where you are. You can view this information from the Time Log form.

Checking In and Out

Checking in and out informs others of your whereabouts. When you check out, you can also enter a remark,
return date, and return time. If you do not enter a remark, the system supplies the wordhome. If you do not
enter a return date, the system enters the next business day. The check in and check out information that
appears on the Time Log form is discussed later in this topic.

Access the Work With Employee Queue Manager form.
1. On Work With Employee Queue Manager, locate and select your record.
2. From the Row menu, select one of these menu options:

* Check In

* Check Out

Each time you select Check In or Check Out, the system updates your status, which you can view
from the Time Log.

Entering Remarks

You can enter a remark to provide more information about your whereabouts, your schedule, and so on. For
example, you might enter a remark indicating that you are in a meeting, on vacation, or can be reached at a
particular phone number. You can update an existing remark.

Access the Work With Employee Queue Manager form.

1. On Work With Employee Queue Manager, locate and select your record.
2. From the Row menu, select Remark.

3. On the Check In/Out and Update Remark form, select the Update Remark option.
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4. Enter your remark in the Remark field.
The following fields in the Return area are optional; complete them if necessary:
* Return Time
» Return Date

6. Click OK.

7. To view your remark, click Find on Work With Employee Queue Manager.

Viewing Time Logs
You can view the times when you or other employees check in and out, and you can view any remarks.
Access the Work With Employee Queue Manager form.

1. On Work with Employee Queue Manager, select the employee record time log that you want to view.

2. From the Row menu, select Time Log.

46 Copyright © 2006, Oracle. All rights reserved.



CHAPTER 8

Working with Media Object Attachments

This chapter provides an overview of media object attachments and discusses how to:

* Work with media objects.
 Attach media objects.

* Search for media objects.
* Work with templates.

» Work with properties.

* Work with metadata.

Attach OLE objects at the baser for level.

Understanding Media Object Attachments

JD Edwards EnterpriseOne software media objects and imaging features enable you to attach useful
information to an application, including information that might currently exist as a paper-based document.
The media objects feature enables you to attach the information to JD Edwards EnterpriseOne software
applications, forms and rows, and Object Librarian objects. The imaging feature within media objects gives
you the flexibility to create an efficient method of information storage.

Use media objects to link information to applications, either to individual rows in a grid or to a form. The
following list discusses the types of information that you can attach to a grid row or form:

Information

Description

Text

Media objects provides a word processor that lets you
create a text-only attachment. For example, you could use a
text attachment to provide specific instructions for a form
or additional information about a record.

Image

Images include files such as Windows bitmaps, Graphics
Interchange Format (GIF) files, and Joint Photographic
Experts Group (JPG) files. These files might represent
electronically created files as well as scanned images of
paper-based documents.
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Information Description

Object Linking and Embedding (OLE) Media objects can be files that conform to the OLE
standard. OLE enables you to create links among different
programs. Using these links, you can create and edit an
object from one program through a different program. JD
Edwards EnterpriseOne software provides the links that
you need to attach OLE objects.

You attach OLE media objects at the base form level.
Media objects attached at this level are attached to a form
and not to any data that might appear in the form. You

can attach media objects to a grid row or a form, but the
files themselves exist in separate directories. The only file
information included with the application to which the
OLE links is the path to the supporting file.

You can only use OLE objects that you properly register
and install as OLE objects through Windows.

JDE shortcuts A JDE shortcut is a link that opens a JD Edwards
EnterpriseOne software application. Within media objects,
you can only attach JD Edwards EnterpriseOne software
shortcuts; you cannot attach shortcuts to third-party
applications.

Uniform Resource Locators (URL)/files Media objects can be links to Web page URLSs or other
related files. When a developer attaches a URL media
object to a control object on a form, the Web page appears
as part of the form. When a user attaches a URL to a form
or Object Librarian object, the media object acts as a link
to the URL.

System administrators can set up templates that might include their own attachments, such as images and
shortcuts. For example, you can create a letterhead and a standard form for a memo. Also, you might create a
shortcut, to be included in the template, that provides access to an application that uses data specific to the
information that you add to the template.

Each time you save a media object, whether it is a new media object, or whether you have modified an existing
one, EnterpriseOne timestamps the media object with your user ID, the date, and time. This information
displays in the upper right corner of the media object. The information that displays is retrieved from the
Enterprise server, so if your Enterprise server resides in a different time zone, the time and date that displays
will be different than the time zone in which you are working. For example, if you work in the Eastern time
zone, but the Enterprise server you are using resides in the Pacific time zone, the date and time that is recorded
when you save the media object will be Pacific time.

Note. If you open a Microsoft Excel OLE media object, place the cursor in the spreadsheet, then click Save,
EnterpriseOne timestamps the media object even if you have not made changes.

Working with Media Objects

This section provides an overview of working with media objects and discusses how to:

¢ Check for attachments

* Check for attachments for a single row or a range of rows
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Understanding how to Work with Media Objects

You can use the Media Objects feature to add text, graphics, and other objects to forms and records. For
example, you can use a text attachment to explain special circumstances surrounding a journal entry. Or you
can attach drawings, animations, and other types of objects to forms and records. A pop-up menu provides
access to established templates for attachments and an option to set the properties for the Media Objects form.

When you attach a media object to a form, the attachment might not be available if you access different data
on the form. For example, if you attach a media object to a detail form that contains data for Order Number
2002, this attachment does not appear on the detail form that appears when you access data for Order Number
3003. The base form, which in this case is a detail form, is the same for both Order Numbers, but the data
associated with the form is specific to each Order Number. The Order Number represents the key to the
location where an attachment is stored.

JD Edwards EnterpriseOne software supports Object Linking and Embedding (OLE). OLE enables you to
create links among different programs. Using these links, you can save an object from one program into a
different program. The system provides the links that you need to attach OLE objects. You can attach OLE
objects as media objects and at the base form level. When you attach an object at the base level of the form,
you attach the object to the form and not to any data that might appear in the form.

If attachments exist for a form, a paper clip button appears at the right of the status bar when you open the form.
For an OLE object attached at the base form level, a document button appears at the right of the status bar.

When a form first opens, grid rows do not indicate whether attachments exist for the corresponding records.
You can perform a search on every record that the system loads onto your workstation or you can search each
record to determine whether attachments exist for records.

The Text feature includes a word processor that lets you create, view, edit, and delete notes. When you create
a text attachment, you can also set up templates. You can use templates to create a format for a frequently
used media object.

Checking for Attachments

To find out whether an attachment exists for a record, you must first perform a search on the record. You can
perform this search on one record or on a number of records simultaneously. The system only searches for
attachments on records that you load onto your workstation. For example, when you initially click the Find
button to locate a number of records, only the records that appear in the grid exist on your workstation. Use
the page buttons to view more records.

When you click the Find button to refresh the records in the grid or to display new records, the form resets
the attachments view status. You must click the find attachments button again to display the attachments for
the grid records.

Access a form with the attachments feature available.
To check for all attachments:

On a form with the attachments feature available, click the Checking for Attachments button to the left of the
row of column titles. This button looks like a paper clip overlapping a magnifying glass.

A paper clip button appears in the row header for each loaded record with an attachment.

Checking for Attachments for a Single Row or a Range of Rows

Access a form with the attachments feature available.

1. On a form with the attachments feature available, hold the cursor over the row header for the grid row.
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If an attachment exists for the row, a paper clip button appears in the row header.

2. Move the cursor up or down in the row header column to search for attachments for adjacent rows.

Attaching Media Objects

50

This section provides an overview about attaching media objects and discusses how to:

* Attach text

* Attach and image

» Attach an OLE object
» Attach a shortcut
Attach URL or file

Understanding how to Attach Media Objects

Use the Attachments feature to attach text, photos, drawings, spreadsheets, video images, sounds, and
application shortcuts to forms and grid rows. For example, you might attach the image of an invoice to a data
entry record, attach a legal document to a record that describes a contractual agreement, or attach text that
describes a process on a form. The attachments feature is not available on all forms.

Note. You cannot create attachments until an administrator has established and mapped media object queues as
described in Media Objects and Imaging in the System Administration Guide.

When you enter text, you can format the paragraphs and run a spell check. JD Edwards EnterpriseOne software
also supports object linking and embedding (OLE).

Attaching Text

Access a form with the attachments feature available.

1. On a form where attachments are available, do one of these tasks:
* To attach text to a form, from the Form menu, select Attachments.
If attachments exist for the form, click the paper clip button to the right of the status bar.
+ To attach text to a grid row, select the row and then, from the Row menu, select Attachments.

The Media Objects workspace is split into two panels. The left panel is the button panel and the right
panel is the viewer panel. Icons for any files previously attached to the record appear in the button panel.

2. Do one of these tasks:
» From the File menu, select New, and then Text.
* In the button panel, click the right mouse button, select New, and then select Text from the pop-up menu.
In the viewer panel, type the desired text.

4. When you finish, from the File menu, select Save and Exit.

You can use the formatting tools at the top of the viewer panel to format the text of your note.
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Attaching a File

Access a form where attachments are available.

L.

On a form where attachments are available, do one of these tasks:
* To attach an image to a form, from the Form menu, select Attachments.
If attachments exist for the form, click the paper clip button to the right of the status bar.
* To attach an image to a grid row, select the row and then, from the Row menu, select Attachments.
On Media Objects, do one of these tasks:
* From the File menu, select New and then Image.

* In the button panel, click the right mouse button, select New, and then select Image from the pop-up
menu.

Complete these options:
* Queue Name
* Files of Type

The Preview option contains a default check mark to display a sample of the selected image. Toggle
this option to display or hide the preview image.

Choose an image, and then click OK.
If the system supports the graphic format, the image appears in the viewer panel.

When you finish, from the File menu, select Save and Exit.

Field Explanation
Queue Name The name of the directory where the image file exists.
Files of Type The list of file extensions that the system supports. For

example, file types might include .bmp for a Windows
bitmap, .gif for a graphics interchange format file, and

jpg for a joint photographic experts group file.

Attaching an OLE Object

Access a form where attachments are available.

1.

On a form where attachments are available, do one of these tasks:
* To attach an OLE object to a form, from the Form menu, select Attachments.
If attachments exist for the form, click the paper clip button to the right of the status bar.
 To attach an OLE object to a grid row, select the row and then, from the Row menu, select Attachments.
On Media Objects, do one of these tasks:
» From the File menu, select New and then OLE.
* In the button panel, click the right mouse button, select New, and then select OLE from the pop-up menu.
On Insert Object, to create a new object, select an object type and click OK.

Selections vary from system to system depending on what the system administrator installs on your
workstation and on the network.
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Create your object.
To attach an existing object, select Create from File, locate the object on your system, and then click OK.

Depending on whether you create an object or attach an existing object, the application associated with the
object displays in the viewer panel either a blank workspace or the existing object.

The menu bar displays the menus for the application from which you call the object. For example, if you
select an Excel document, the Excel menus display on the menu bar.

On Media Objects, edit the object in the viewer panel as necessary.

When you finish, from the File menu, select Save and Exit.

Attaching a Shortcut

Access a form where attachments are available.

Include a shortcut to provide access directly from a record to an associated application.

1.

On a form where attachments are available, do one of these tasks:
* To attach a shortcut to a form, from the Form menu, select Attachments.
If attachments exist for the form, click the paper clip button to the right of the status bar.
+ To attach a shortcut to a grid row, select the row and then, from the Row menu, select Attachments.
On Media Objects, do one of these options:
» From the File menu, select New and then Shortcut.

* In the button panel, click the right mouse button, select New, and then select Shortcut from the pop-up
menu.

On Open, browse through your files, select the appropriate shortcut, and click Open.
Your shortcut appears in the viewer panel.

When you finish, from the File menu, select Save and Exit.

Attaching a URL or File

Access a form where attachments are available.

Attach a URL to provide access to a Web page or a file on a disk. You can also attach file types that cannot be
attached as images or OLE files, such as bitmaps.

1.

On a form where attachments are available, do one of these tasks:
 To attach a URL or file to a form, from the Form menu, select Attachments.
If attachments exist for the form, click the paper clip button to the right of the status bar.
 To attach a URL or file to a grid row, select the row and then, from the Row menu, select Attachments.
On Media Objects, do one of these tasks:
» From the File menu, select New and then URL/File.

* In the button panel, click the right mouse button, select New, and then select URL/File from the pop-up
menu.

On Add URL/File, browse your files or queues, select the appropriate URL or file, and click Open.
You can also type a URL in the field.
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4. Click OK.

Your URL or file appears in the viewer panel. If you are attaching a URL, a download dialog box appears.
You can either verify that the URL is active or you can click Cancel.

5. When you finish, from the File menu, select Save and Exit.

Searching for Media Objects
This section provides an overview of searching for media objects and discusses how to:

* Search for a media object
* Rename attachments

* Delete media objects

Understanding how to Search for Media Objects

You can search for a specific media object in the system by using information such as creation date, alternate
keys, or UDCs.

Note. You can only search for media objects that already have codes defined for them and that your system
administrator has made available to all users in the system.

Searching for a Media Object
Access a form where attachments are available.
1. On a form where attachments are available, do one of these tasks:
+ To search for a media object to attach to a form, from the Form menu, select Attachments.
If attachments exist for the form, click the paper clip button to the right of the status bar.

» To search for a media object to attach to a grid row, select the row, and then from the Row menu,
select Attachments.

2. On Media Objects, do one of these tasks:

e From the File menu, select New and then Search.

+ In the button panel, click the right mouse button, select New, and then Search from the pop-up menu.
3. On Media Object Search, complete the Type field and click Find.

Enter the type of media object attachment for which you are searching. You can use the Query by Example
line to limit your search.

Only attachments with defined metadata appear.
4. Choose an attachment and click Select.
Your media object appears in the viewer panel.

5. When you finish, from the File menu, select Save and Exit.
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Renaming Attachments

When you add an attachment, the system displays its filename under its button in the button panel. You can
rename the button to make it more meaningful to other users if you want.

Access media objects.

1. On Media Objects, select a button and do one of these tasks:
* From the File menu, select Rename.
* In the button panel, click the right mouse button and select Rename from the pop-up menu.

2. Type a new name for the button and then click anywhere on the form.

Deleting Media Objects

When you no longer need an attachment, use the Delete feature on Media Objects to remove the object. When
you delete text, the text is permanently erased. When you delete images and OLE objects, you remove the
attachment of the file to the record. The system continues to store a file for the object.

Access a form where attachments are available.

1. Complete one of these tasks:
* To delete an attachment to a form, from the Form menu, select Attachments.
If attachments exist for the form, click the paper clip button to the right of the status bar.

* To delete an attachment to a grid row, select a row with a paper clip button, and then, from the Row
menu, select Attachments.

2. On Media Objects, select the appropriate button in the button panel and then select Delete from the
File menu.

3. On Confirm Media Object Delete, click Yes to confirm the deletion.
The button disappears from the button panel.

4. When you finish, from the File menu, select Save and Exit.

Working with Templates
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This section discusses how to:
* Create a template

* Attach a template

* Modify a template

* Delete a template

* Delete a template with media objects

Creating a Template

On Media Objects, you can access the Work With Media Objects Templates form. On this form, you can
attach, create, modify, and delete templates to help you format your text attachments.
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Access a form where attachments are available.

1.
2.

Select the row from which you want to attach a template, and then select Attachments from the Row menu.

On Media Objects, in the button panel, click the right mouse button and select Templates from the pop-up
menu.

On Media Objects Template, click Add.

On Media Object Template Revisions, complete these fields, and then enter your template information into
the workspace:

* Template Name
* Description
Click Add.

Attaching a Template

Access a form where attachments are available.

1.
2.

Select the row to which you want to attach a template, and then select Attachments from the Row menu.

On Media Objects, in the button panel, click the right mouse button and select Templates from the pop-up
menu.

On Work With Media Object Templates, click Find.

You can use the query-by-example line to refine your search.

To preview the template, double-click the paper clip button in the row header.
Choose the grid row for the template that you want to attach, and then click Select.
The template appears in the workspace on Media Objects.

Modifying a Template

Access a form where attachments are available.

1.
2.

Select the row from which you want to modify a template, and then select Attachments from the Row menu.

On Media Objects, in the button panel, click the right mouse button and then select Templates from
the pop-up menu.

On Work With Media Object Templates, click Find.
You can use the Query by Example line to refine your search.
Choose the grid row for the template that you want to modify and then click Select.

On Media Objects, modify the template as necessary and then from the File menu, select Save and Exit.

Deleting a Template

Access a form where attachments are available.

1.
2.

Select the row from which you want to delete a template, and then select Attachments from the Row menu.

On Media Objects, in the button panel, click the right mouse button and then select Templates from
the pop-up menu.

On Work With Media Object Templates, click Find.

Copyright © 2006, Oracle. All rights reserved. 55



Working with Media Object Attachments Chapter 8

You can use the Query By Example line to refine your search.

4. Choose the grid row for the template that you want to delete, click Delete, and then on Confirm Delete,
click OK.

Deleting a Template on Media Objects
Access a form where attachments are available.

1. Select the row from which you want to delete a template, and then select Attachments from the Row menu.

2. On Media Objects, in the button panel, select the text button for the template, and then select Delete
from the File menu.

3. On Confirm Media Object Delete, click Yes.
The template and the text button disappear.

Working with the Properties of Media Objects

This section discusses how to:

* Set media object properties
 Set text properties

* Set image properties

» View OLE properties

* Set shortcut properties

Setting Media Object Properties

The pop-up menu that appears when you click the right mouse button in the button panel on Media Objects
provides you with the option to view and, for some objects, to change the properties of an object. Each
object has unique properties.

In addition, you can define metadata for an object. Metadata contains information about the object, such as a
description of the object, who created it, and when it was created. Other users can search for the object
based on this information.

Access Media Objects.
1. On Media Objects, in the button panel, click the right mouse button and then select Properties.
The form or row must contain an attachment in order to access the Media Objects properties.
2. On Properties, review the "Technical information about the key for the form" on the Key Information tab.
Click the Flags tab and review this information:
» Allow Text Items
» Allow Image Item
» Allow OLE Items
» Allow RTF Text
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* Show Text Item On Open
* Read Only

Setting Text Properties
Access Media Objects.

1. On Media Objects, in the button panel, click the right mouse button over a text button, and then select
Properties from the pop-up menu.

2. On the text properties form, review these fields on User Audit Information:
¢ Created by
* Date Created
* Time Created
* Updated By
» Date Updated
* Time Updated
3. Click the Printing Information tab and then do the following, if necessary:
* Click the Check to print before report item option
» Complete the Effective From field
» Complete the Effective To field

Setting Image Properties
Access Media Objects.

1. On Media Objects, in the button panel, click the right mouse button over an image button, and then
select Properties from the pop-up menu.

2. On the Image Properties tab, review these fields:
* File Name
* Queue Name
* Queue Path
3. To give the image a title, complete the Description field.

Viewing OLE properties
Access a form where attachments are available.

1. On Media Objects, in the button panel, click the right mouse button over an OLE object button, and then
select Properties from the pop-up menu.

2. On the OLE Object Properties tab, review these fields:
* File Name
* Queue Name
* Queue Path
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Setting Shortcut Properties
Access Media Objects.

1. On Media Objects, in the button panel, click the right mouse button over a shortcut button, and then
select Properties from the pop-up menu.

2. On the JDEShortcut Control Properties form, review these fields on the General tab:
* Menu Name
* Selection
* Icon File
* Icon Index
3. Do these tasks, if necessary:
* Click the Colors tab to set the color for the shortcut hypertext.

* Click the Fonts tab to set font properties such as size, family, bold, italics, underline, and strikeout.

Working with Metadata to Media Objects

This section discusses how to:

» Enable metadata fields for media objects

* View and define metadata

Enabling Metadata Fields for Media Objects

The system enables you to add information to media objects in the form of metadata. Metadata can include
items such as author, creation date, and language of the media object attachment.

Before you can add metadata, you must enable the metadata fields for the media object in the Media Object
Category Constants program (P00167).

To enable metadata fields for media objects:
From the GH9016 menu, select Media Object Constants (P00167).
1. On Work With Media Object Category Constants, find the media object that you want to enable.

The system will enable the metadata fields for all the media objects that are associated with the media
object that you select.

2. Highlight the media object and then click Select.

On the General tab of Media Object Category Constants Revisions, select the check boxes next to the
available metadata field options to enable those metadata fields in the media object.

4. Click OK.

Viewing and Defining Metadata

Access a form with an attachment.
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1. On any form with an attachment, in the Media Objects button panel, right-click an object button, and then
select Characterize Object from the pop-up menu.

2. On the Media Object Category Revisions form, click the General tab, and then complete the available
fields for the media object.

3. Click OK.
Description Glossary

Description A short description to describe what the media object
is about.

Author This is the author of the media object document or
attachment.

Creation Date For World, used in the DDS specifications for IBM’s
file-field reference display.

Status Indicate if this media object is active or obsolete.

Attaching OLE Objects at the Base Form Level

The section discusses how to:

» Attach OLE objects at the base form level
» Delete OLE objects at the base form level

Attaching OLE Objects at the Base Form Level

At the base level of a standard form, you can attach OLE objects using the OLE Objects button on the Links
toolbar. Menu bars and toolbars appear on all standard forms. When you attach an OLE object at the base level
of a form, rather than associating the attachment with a record, the OLE object attaches only to the form. No
matter what record appears on the form, the OLE object that you attach using the OLE Objects button will
always appear when you open the form.

Access a standard form.
1. Complete one of these tasks:
* From the Links toolbar, select Preferences, and then OLE Objects.
* From the Preferences menu, select OLE Objects.
+ If attachments exist for the form, click the document button to the right of the status bar.

2. On the Choose Queue form, select the appropriate queue.

Note. If you do not know the queue in which the object you want to attach exists, ask your system
administrator.

3. On the OLE Objects form, do one of the following:
* From the File menu, select Add Object.
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* In the button panel, click the right mouse button and then select Add Object.
On Insert Object, to create a new object, select the type of object that you want to create and then click OK.

Selections vary from system to system depending on what the system administrator installs on your
workstation and on the network.

Create your object.
To attach an existing object, select Create from File, locate the object on your system, and then click OK.

Depending on whether you create an object or attach an existing object, the application associated with the
object displays either a blank workspace or the existing object in the viewer panel.

The menu bar displays the menus for the application from which you call the object. For example, if you
select an Excel document, Excel menus display on the menu bar.

Edit the object in the viewer panel.

To return to the main form, click the X button on the OLE Objects form in the application workspace.

Deleting OLE Objects at the Base Form Level

Access a standard form.

L.

Complete one of these tasks:

» From the Links toolbar, select Preferences and then select OLE Objects.

» From the Preferences menu, select OLE Objects.

* Click the document button to the right of the status bar.

On the OLE Objects form, select the object and complete one of these tasks:
» From the File menu, select Delete Object.

* In the button panel, click the right mouse button and select Delete Object.
On Confirm Media Object Delete, click Yes.

To return to the main form, click the X button on the OLE Objects form in the application workspace.
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Using MailMerge Workbench

This chapter provides an overview of the MailMerge workbench and discusses how to work with MailMerge
documents.

Understanding MailMerge Workbench

MailMerge Workbench merges Microsoft Word 6.0 (or higher) word processing documents with JD Edwards
EnterpriseOne system records to automatically print business documents, such as form letters. Some
application suites, such as Human Resource Management, use these documents within their normal workflow
process. See your application guides to determine which applications use mail-merge documents. In these
applications, the system automatically prints the mail-merge documents as part of the workflow process, and
no user intervention is needed.

You can use the Maintain MailMerge Documents application to add or change text in the business documents
included with JD Edwards EnterpriseOne software to create new documents and to delete documents.

JD Edwards EnterpriseOne software enables you to create HTML versions of mail-merge documents to send to
Web client users. After you add text and fields to the mail-merge document, you can copy it to an HTML
version so that you can send mail-merge letters to Web client users. When a mail-merge letter is generated, the
system displays the letter in the Web Mail Merge program (P980040).

Creating a Data Set and Attaching Templates

This section provides an overview of data set and discusses how to create a data set and how to attach
templates to the data set.

Understanding Data Sets

A data set is the way you define the data structure that passes data to the API. After you define the data
set, you will attach to it a simple template or a composite template. A simple template is a single template
that you attach to a data set. A composite template is a collection of simple templates. Use only templates
in the .rtf format.

Attaching Templates to a Data Set

After you have created a data set, you must attach either a simple template, or a composite template.

Copyright © 2006, Oracle. All rights reserved. 61



Using MailMerge Workbench Chapter 9

62 Copyright © 2006, Oracle. All rights reserved.



CHAPTER 10

Using Processing Options

The chapter provides overviews for processing options, processing option functions, and types of processing options,
and discusses how to work with processing options.

Understanding Processing Options

A processing option is a parameter in which you enter a value to control how an interactive or batch program
runs.

You use processing options to instruct the system to perform functions to meet your specific business needs. If
a program contains processing options, you set the required and optional processing options for the program
during setup or before you run or submit a program.

You can create different versions of each program if your business needs require specific processing for
different processes. You can then set these unique processing options differently in multiple versions of the
same application. Changes to processing options immediately affect that version for every user. Anyone
who uses that version after you make the change uses the new processing option values. You can also use
processing options to access a version of another program.

Important! XJDE versions are considered owned by JD Edwards. During an upgrade, the system might
overwrite these versions. You should use these versions only as templates for your own versions.

ZJDE versions are used for default purposes, and are typically interactive applications or versions called from
another application. You usually attach these versions to a menu. You can set these processing options.
When called from a menu, interactive applications with a version are called with a blind execution based on
predetermined processing option values.

Understanding Processing Option Functions

Use processing options to complete one of these tasks:

* Set up default values
» Customize an application for different companies or even different users
* Control the format of forms and reports

» Control page breaks and the location where totaling occurs for reports

Processing options appear in the system as a tabbed form. Tabs organize the processing options by purpose and
function. Each processing option tab contains these items:
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* A standard or unique tab name
* Processing option titles

» Lists of values

Online help (enhanced processing options)

You access field-level help by placing the cursor is in a field and pressing F1 or by clicking the Item Help
icon located at the top-right corner of a form. If the field in which the cursor resides is a business view
column, the system displays the alias name, business view name and description, table name and description,
and glossary text. If the field in which your cursor resides is a data dictionary column, the system displays
the alias name, the term Data Dictionary Item, and the glossary text. This information enables you to identify
problems in the item help functionality, should any occur.

Note. If your system administrator has not turned on the appropriate functionality, you will see only the
alias name and glossary text.

Understanding the Types of Processing Options

Processing options can be of two types: enhanced and nonenhanced.

Enhanced processing options provide detailed user information. For example, the user can look at the field
name and values on the tab and quickly determine how to use the processing option; or the user can access
online help by pressing F1 on the processing option for a detailed explanation. These processing options
have been enhanced to JD Edwards EnterpriseOne standards. Enhanced processing option forms have a
number, a brief title, and, if applicable, a concise list of values. These processing options have online help
attached to them.

Nonenhanced processing options provide only a brief description in paragraph form. Sometimes these fields
have no title; instead, they are numbered, and each number is followed by a brief explanation, in paragraph
form, of relevant information (usually values). The processing option numbers sometimes span all tabs.
The fields typically have data items attached but do not follow the same naming conventions as enhanced
processing options

Working with Processing Options
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This section provides an overview for working with process options and interactive and batch version
processing options.
Understanding Processing Options

You can work with processing options in these two ways:
* From a menu

* From a version list

How Processing Options Work From a Menu

You can access processing options for an object either from the menu bar or by right-clicking the object. In
either case, one of the options is Prompt For. The Prompt For submenu contains these options, when available:
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Options Description
Values Choose this option to specify processing option values.
Version Choose this option to select which version of the object

to run. Depending on how the version was designed, you
might be prompted to enter processing option values after
you select the version, or you might be able to modify them
from the Row menu.

Data Selection Choose this option to specify which data to use.

Data Selection and Values Choose this option to specify which data to use and then to
specify processing option values.

If you select to run processing options from a menu, the processing details defined at the menu level take
precedence. Not all objects enable you to select from all four of these options.

Using Interactive Version Processing Options

The processing options that you define in interactive versions are a set of parameters that alter how an
application runs. They are similar to initialization (.ini) files and command-line arguments for a traditional
executable. These processing options let you specify the options that you want when you open an application.
For example, you can specify how a form appears, show or hide a field, change the default status for order
activity rules, and set default information to appear in a field.

Not all JD Edwards EnterpriseOne software applications have processing options. If the Prompt For Values
option on the Edit menu is grayed out, either no processing options are associated with the application or the
system administrator has secured a version for the application. When you open a secured version from the
Interactive Versions application, a security message appears to inform you that you do not have access to
the version.

You must set processing options for an interactive application before you use versions with the application.

Using processing options, you set up interactive programs to suit your business requirements. For interactive
versions, processing options complete these tasks:

* Change functions. For example, you can set a processing option to turn on or off order holds. You can
also specify whether you want to automatically print pick slips after you enter an order that is based on a
processing option value.

* Change default values. For example, you can set the processing options to set defaults for document types
(such as quote orders or purchase orders) or line types (such as stock or nonstock items).

* Control the display of forms. For example, you can set the processing options to hide or show a cost
field, a price field, or a commission field.

Access a Solution Explorer task view.

1. From the EnterpriseOne Menu, click the application for which you want to set processing options.
2. Click the and select Prompt For Values from the menu.

3. On Processing Options, enter appropriate values where applicable and click OK.
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Using Version Processing Options

You can change the processing options for an existing batch version to suit your business requirements. For
example, you can change processing option values that specify a range of dates for a report. However, not
all batch versions have processing options associated with them. For example, a list of addresses might
not require special prompting.

For batch versions, processing options complete these tasks:

* Change functionality. For example, you can set a processing option to move records to a history file after a
report runs.

* Change input parameters. For example, you can set a processing option to specify which category code to
use when processing a report.

* Define data. For example, you can set a processing option to define the fiscal year for which you want to run
a report. You can also define the employee information included in a report.

Launching Processing Options for Batch Versions Manually
Access a Solution Explorer task view.

1. From a EnterpriseOne Menu, select the batch version application for which you want to set processing
options.

2. On Work With Batch Versions - Available Versions, find and click a version of the report or other batch
application.

On Work With Batch Versions - Available Versions, select Processing Options from the Row menu.

4. On Processing Options, enter appropriate values where applicable and click OK.

Using Processing Options for Master Business Functions

The purpose of a master business function (MBF) is to provide a central location for standard business rules
about entering documents such as vouchers, invoices, and journal entries.

The MBF is composed of processing options that are shared by some programs. For example, the following
journal entry programs use the processing options for the journal entry MBF:

* Journal Entries (P0911)

* Journal Entries with VAT (P09106)

* Journal Entry Batch Processor (R09110Z)

« Store and Forward JE Batch Processor (R09110ZS)

* Recurring Journal Entry Compute & Print (R09302)
* Indexed Comp Compute and Print Report(R093021)
* Variable Numerator Compute and Print (R093022)

Access Work With Interactive Versions from the System Administration Tools menu (GH9011).

1. Type the application number in the Interactive Application field and click Find. For example, type
P0900049.

2. Choose a version.

3. To review the processing option settings for the version, select Processing Options from the Row menu.
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Hot Keys

This appendix provides an overview about hot keys and identifies hot keys for these categories:

» Keyboard Shortcuts

* EnterpriseOne Menu

* Tree Grid

* Button Hot Keys

» Keyboard Shortcuts for the Calendar Tool

* Web Client Keyboard Shortcuts for the Calculator Tool
» Keyboard Shortcuts for Media Object Text

» Keyboard Shortcuts for the Calendar Control
* Moving in the Grid

» Keyboard Shortcuts for Media Object Text

* Moving in the Grid

Understanding Hot Keys

Menu options and buttons throughout the system include key combinations, or hot keys, that perform the same
functions as using the mouse. All of the standard push buttons in the system have hot keys associated with them.

You can recognize hot keys by the underline on a control or menu. For example, the I on the Find button is
underlined. Press Ctrl + Alt + I to use this control.

The hot keys work in both the Windows client and Web Client of JD Edwards EnterpriseOne software,
except where noted.

Note. In the JD Edwards EnterpriseOne web client, all hot key combinations that use the Alt key only work
with the left Alt key. The right Alt key is used for typing special characters for foreign languages.

Keyboard Shortcuts

The hot keys listed in the following tables are capitalized only to make them easier to read. You do not need to
press the shift key to utilize hot key functionality unless the shift key is specifically listed.
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Hot Keys Action

F1 Access field help

F2 (web only) Launch search button/Calendar/Calculator button on the
current field.

Alt + Tab Switch between all open applications on your PC.

F8 (web only) Move focus to the EnterpriseOne Menu and loop between
open applications.

F12 (web client only) Move focus to the first focus-enabled control in the next

group of controls.

Shift + F12(web client only)

Move focus to the first focus-enabled control in the
previous group of controls.

Alt+ 1 through Alt+ 9 (web client only)

With focus on tab-sets, Alt + 1 shows the first tab, Alt + 2
shows the second and so forth, up to the 9th tab

Ctrl + Alt + 1 through Ctrl + Alt+9

With focus on subtab sets, Ctrl + Alt + 1 shows the first
subtab, Ctr]l + Alt + 2 shows the second subtab, and so on,
up to the ninth subtab.

Alt+ N (web client only)

Launch new window

Alt+M (web client only)

Minimize/maximize EnterpriseOne Menu

Ctrl + Shift + J (web client only)

Launch System Information

Ctrl + Shift + K (web client only)

Launch keyboard information help

Alt+ K (web client only) Expand/Collapse subform or container

Alt+Q (web client only) Move focus to first or next issue (error or warning) field.
Move focus back to the first issue after reaching the last
issue.

Cul+A Selects all text in a field.

Ctrl+X Cut or delete selected text

Ctl+V Paste cut or copied text to the new area

Ctrl+C Copy selected text

Ctrl + Alt + P (web client only) Open Report menu

Ctrl + Alt + T (web client only)

Open Tools menu

Ctrl + Alt + F (web client only)

Open Form menu
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Hot Keys

Action

Ctrl + Alt + R (web client only)

Open Row menu

Up or Down Arrows

Move focus up or down between options on fly out menus.
Press Enter to launch the option.

EnterpriseOne Menu

Hot Keys

Action

Alt+/ (web client only)

Move focus to Fast Path when in EnterpriseOne Menu

Up and Down Arrows (web client only)

Move focus up or down from present node in navigation
tree. If next node is a child node, move focus to it

Right Arrow (web client only)

Expand present node in navigation tree

Left Arrow (web client only)

Collapse present node in navigation tree

Enter (web client only)

Launch end node if hyperlinked. If parent node, expand it.
If expanded, collapses it

Tree Grid

Hot Keys Action
Ctrl + Shift + Right Arrow (web client only) Expand node
Ctrl + Shift + Left Arrow (web client only) Collapse node
Button Hot Keys
Hot Keys Action
Ctrl + Alt + A (web client only) Add

Ctrl + Alt + B (web client only)

Save for Later, Back on Media Object Viewer form

Ctrl + Alt+ D (web client only)

Delete

Ctrl + Alt + E (web client only)

Save and Continue, Continue in Import/Export Grid Data
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Hot Keys

Action

Ctrl + Alt + F (web client only)

Open Form menu, place focus on first option

Ctrl + Alt + G (web client only)

Assign

Ctrl + Alt + I (web client only)

Find, File Media Object view/add form

Ctrl + Alt + L (web client only)

Cancel/Close

Ctrl + Alt + M (web client only)

Remove, New Template on Media Object Viewer form

Ctrl + Alt + N (web client only)

Save and Add New

Ctrl + Alt + O (web client only)

OK, Save and Close, Submit, New OLE Media Object on
Media Object Viewer form

Ctrl + Alt + P (web client only)

Open Reports menu, place focus on first option

Ctrl + Alt + R (web client only)

Open Row menu, place focus on first option

Ctrl + Alt + S (web client only)

Select

Ctrl + Alt + T (web client only)

Open Tools menu, place focus on first option

Ctrl + Alt + U (web client only)

Undo Changes, Enter URL on Media Object Viewer form

Ctrl + Alt+ V (web client only)

Save, Save Changes

Ctrl + Alt + X (web client only)

New Text media object on Media Object Viewer form

Ctrl + Alt+Y (web client only)

Copy

Ctrl + Alt + Z (web client only)

Characterize on Media Object Viewer form

Ctrl + Alt+ Up Arrow (web client only)

Move selection up in Data Selection and Sequencing dialog

Ctrl + Alt+ Down Arrow (web client only)

Move selection down in Data Selection and Sequencing
dialog

Keyboard Shortcuts for the Calendar Tool

Hot Keys

Action

Page Up

Move to previous month.

Page Down

Move to next month.

Home (web client only)

Move to previous year.

End (web client only)

Move to the next year.
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Hot Keys

Action

Enter (web client only)

Close the Calendar and set the current value to the input
field with search button (OK action).

Escape (web client only)

Close the Calendar and return to the input field with search
button (Cancel action).

Web Client Keyboard Shortcuts for the Calculator Tool

Hot Keys

Action

Backspace (web client only)

Remove one digit from calculator display.

F9 (web client only)

Change the sign of the number on calculator display.

= or Enter (web client only)

Evaluate and display the result.

Escape (web client only)

Clear the calculator display.

Digit Key (0123456789.) (web client only)

Show the number in the display field.

%, *, +, -,/ (web client only)

Perform an operation corresponding to the key stroke and
display the result.

@ (web client only)

Perform square root operation.

R or r (web client only)

1/X Operation.

O (web client only) Close the calculator and set the current value to the input
field with search button (OK action).
C (web client only) Close the calculator and return to the input field with search

button (cancel action).

Keyboard Shortcuts for Media Object Text

Hot Keys Action
Ctrl + B Bold the selected text
Ctrl+1 Italicize the selected text
Ctrl+U Underline the selected text
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Hot Keys

Action

Ctrl + Shift+L

Create a bullet

Ctrl + Tab

Exit the text edit form and display the next object in the tab
sequence

Keyboard Shortcuts for Calendar Control

Hot Keys

Action

Ctrl + Alt + D (web client only)

Switch to Day view

Ctrl + Alt + W (web client only)

Switch to Week view

Ctrl + Alt + M (web client only)

Switch to Month view

Ctrl + Alt + Right Arrow (web client only)

Move to next day/week/month as per current view

Ctrl + Alt + Left Arrow (web client only)

Move to previous day/week/month as per current view

Ctrl + Alt + A (web client only)

Add an activity

Ctrl + Alt + E (web client only)

Move focus to first/next event. If All Day Events exist, the
focus is set to the first day to last, from AM to PM. If on
month view, move focus from first day to last.

Moving in the Grid

Hot Keys Action
Tab Move to the next cell. The order is right and then down.
Available only in grids where you can enter information.
Shift + Tab Move focus to previous link, form field, button, or hot
linked button.
Cul+V Paste the Clipboard data into the current cell location.
Ctrl+C Copy the current selection or data in a cell to the Clipboard.

Enter in a grid cell (web client only)

Move focus to first editable field in the row below the
current one.

Spacebar on the Grid Selection Check box (web client
only)

Select the row that the check box represents. A user can
tab through the controls to set focus on the Grid Selection
Check box.
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Hot Keys Action
F2 (web client only) Launch Search button from the current cell.
Alt+/ (web client only) Move focus to first enabled cell in the QBE row, if QBE is
present. Cycle through all QBE cells
ENTER in QBE Trigger Find operation.
PAGE UP Page up (or show previous page of grid data)
PAGE DOWN Page down (or show next page of grid data)
Alt+R (web client only) Maximize/minimize grid
Ctrl + Shift + E (web client only) Export Grid Data
Ctrl + Shift + I (web client only) Import Grid Data

Alt+J (web client only)

On editable grids, set focus on the first editable cell in the
grid.

On non-editable grids, set focus on the row selector for the
first row in the grid.

Up and Down Arrows

Move focus to the field above or below, in the same column

Ctrl + Up Arrow (web client only)

Select previous row

Ctrl + Down Arrow (web client only)

Select next row

Ctrl + Alt + Left Arrow Move focus to first editable cell in current row
Ctrl + Alt + Right Arrow Move focus to last editable cell in current row
ENTER in grid row Move focus to first editable field in the row below
Ctrl + Home Move focus to first row, current column

Ctrl + End Move focus to last row, current column

Ctrl + Alt + [spacebar] (web client only)

Select current row
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JD Edwards EnterpriseOne Software Systems

This appendix provides a list of the JD Edwards EnterpriseOne systems.

JD Edwards EnterpriseOne Software Systems
The following table identifies the JD Edwards EnterpriseOne systems:

Number System
00 Foundation Environment
01 Address Book
02 Electronic Mail
03 Accounts Receivable
0301 Credit Management
03B Enhanced Accounts Receivable
03C Issue Management System
04 Accounts Payable
05 Time Accounting and HRM Base
05A OW HR & PR Foundation
05C OW HR & PR Foundation Canadian
05T Time Entry
05U OW HR & PR Foundation US
06 Do not use
07 Payroll
07S Payroll SUI
07Y U.S. Payroll Year End
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Number System
08 Human Resources
08B Benefits Administration
08C OW HR Canadian
08H Health and Safety
08P Position Control
08R Recruitment Management
08U OW HR US
08W Wage and Salary
09 General Accounting
09E Expense Reimbursement
10 Financial Reporting
10C Multisite Consolidations
11 Multicurrency
11C Cash Basis
12 Fixed Assets
13 Plant/Equipment Management
14 Modeling, Planning & Budgeting
15 Property Management
16 Profit Management (EPS)
17 Customer Service Management
17C Call Management
18 Resource Scheduling
19 Utility CIS
30 Product Data Management
3010 Process Data Management
31 Shop Floor Control
3110 Process Control
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Number System
32 Configuration Management
32C Custom Works
33 Capacity Planning
34 Requirements Planning
34A Advanced Planning & Scheduling
35 Enterprise Facility Planning
36 Forecasting
37 Quality Management
38 Agreement Management
39 Advanced Stock Valuation
40 Inventory/OP Base
4010 Advanced Price Adjustments
41 Inventory Management
41B Bulk Stock Management
42 Sales Management
42A Sales Force Automation
42E ECS Sales Management
43 Procurement
44 Subcontract Management
4401 Homebuilder Management
44H Homebuilder Management
45 Advanced Pricing
46 Warehouse Management
47 Electronic Commerce
48 Work Order Processing
48S Service Billing
49 Transportation Management
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Number System
50 Job Cost Base
51 Job Costing
52 Contract Billing
53 Change Management
55-59 Reserved for Clients
60 - 69 Reserved for JDE Custom
70 Multinational Products
71 Client Server Applications
72 World Vision
73 M & D Complementary Products
74 EMEA Localization
74H Hungary
741 Ireland
74L Portugal
74N Nordics
74P Poland
74R CIS
748 Spain
74T Turkey
747 Czech Republic
75 ASEAN Localization
75H Thailand
751 India
75K Korea
75T Taiwan
76 Latin American Localization
T6A Argentina
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Number System
76B Brazil Localization
76C Colombia
76H Chile
76P Peru
76V Venezuela
77 Payroll (Canadian)
77Y Canada Payroll Year End
79 Translation Tools
80 Business Intelligence
81 DREAM Writer
82 World Writer
&3 Management Reporting - FASTR
84 Distributive Data Processing
85 Custom Programming
86 Electronic Doc. Interchange
87 JDE Internal
88 Cautious Purge System
89 Conversion Programs
91 Documentation
92 Computer Assisted Design
93 Computer Assisted Programming
94 Security Officer
95 Sleeper-now in system 96
96 Computer Operations
97 Software Installation
98 Technical Tools
98E Electronic Burst and Bind
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Number System
98FT Form Type
98SA Sample Application
99 Technical Tools - Internal
99D Technical Tools - DASD Sizer
99M Technical Tools-Masters/Update
B LANGUAGE TRANSLATIONS
B1A Chinese - Simple
B1B Chinese - Complex
B1E English
BI1F French
B1G German
B1I Italian
B1J Japanese
B1P Portuguese
B1S Spanish
B2A Dutch
B2D Danish
B2F Finnish
B2N Norwegian
B2S Swedish
B3C Czech
B3H Hebrew
B3R Russian
BCl1 Chinese - Simple
BC2 Chinese - Complex
BCR Czech
BDN Danish
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Number System
BDU Dutch
BFI Finnish
BFR French
BGR German
BHE Hebrew
BIT Italian
BJP Japanese
BNO Norwegian
BPO Portuguese
BRU Russian
BSP Spanish
BSW Swedish
D3N dcLINK (data collection)
HO1 Address Book (inc. ALL Mail)
HO3 Accounts Receivable
HO3B New Accounts Receivable
HO04 Accounts Payable
HO5 Standalone Time Accounting
HO7 Payroll
HO8 Human Resources
H09 General Accounting
HI12 Fixed Assets
H13 Equipment/Plant Management
H15 Commercial Property Management
H30 Product Data Management
H301 Process Data Management
H31 Shop Floor Control
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Number System
H311 Process Control
H32 Configuration Management
H33 Capacity Requirements Planning
H34 DRP/MRP/MPS
H35 Enterprise Facility Planning
H36 Advanced Forecasting
H40 Inventory/OP Base
H41 Inventory Management
H415 Bulk Inventory Management
H42 Sales Order Processing
H43 Purchase Order Processing
H44 Contract Management
H44H Homebuilder Management
H45 Sales Analysis
H46 Warehouse Management
H50 Job Cost Base
H72 Client/Server Base
H73 CS - A/P Voucher Entry
H74 CS - Pay Time Entry
H75 CS - Sales Order Entry
H76 CS - Training & Development
H78 CS - Travel Expense Management
H79 CS - Forecasting
H90 JD Edwards EnterpriseOne TOOLS
HI1 Design Tools
H92 Interactive Engine/OL
H93 Data Base and Communications
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Number System
H94 Batch Engine
HO95 Tech Resources/Applications
H96 Deployment
H97 Benchmarking/Performance
H98 internet
H99 Product Version Control
H99P Technical Tools-OWPVC Internal
JE42 Sales Order/Pricing
JE44 Distribution Contracts
JE48 Automated Gantry Inter.
K71 PC Budget Upload (A3 to AS)
KZz2 PC Data Entry for AP
KZ3 PC Data Entry for Payroll
SY SYSTEM
7101 MTI Electrical Distribution
7102 CRES
791 System/ Product Codes
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Glossary of JD Edwards EnterpriseOne Terms

activity

activity rule

add mode

Advanced Planning Agent
(APAg)

application server

as if processing

alternate currency

as of processing

back-to-back process

batch processing

batch server

batch-of-one immediate

business function

A scheduling entity in JD Edwards EnterpriseOne tools that represents a designated
amount of time on a calendar.

The criteria by which an object progresses from one given point to the next in a flow.
A condition of a form that enables users to input data.

A JD Edwards EnterpriseOne tool that can be used to extract, transform, and load
enterprise data. APAg supports access to data sources in the form of rational databases,
flat file format, and other data or message encoding, such as XML.

A server in a local area network that contains applications shared by network clients.

A process that enables you to view currency amounts as if they were entered in a
currency different from the domestic and foreign currency of the transaction.

A currency that is different from the domestic currency (when dealing with a
domestic-only transaction) or the domestic and foreign currency of a transaction.

In JD Edwards EnterpriseOne Financial Management, alternate currency processing
enables you to enter receipts and payments in a currency other than the one in which
they were issued.

A process that is run as of a specific point in time to summarize transactions up to that
date. For example, you can run various JD Edwards EnterpriseOne reports as of a
specific date to determine balances and amounts of accounts, units, and so on as of
that date.

A process in JD Edwards EnterpriseOne Supply Management that contains the same
keys that are used in another process.

A process of transferring records from a third-party system to JD Edwards
EnterpriseOne.

In JD Edwards EnterpriseOne Financial Management, batch processing enables

you to transfer invoices and vouchers that are entered in a system other than JD
Edwards EnterpriseOne to JD Edwards EnterpriseOne Accounts Receivable and JD
Edwards EnterpriseOne Accounts Payable, respectively. In addition, you can transfer
address book information, including customer and supplier records, to JD Edwards
EnterpriseOne.

A server that is designated for running batch processing requests. A batch server
typically does not contain a database nor does it run interactive applications.

A transaction method that enables a client application to perform work on a client
workstation, then submit the work all at once to a server application for further
processing. As a batch process is running on the server, the client application can
continue performing other tasks.

See also direct connect and store-and-forward.

A named set of user-created, reusable business rules and logs that can be called
through event rules. Business functions can run a transaction or a subset of a
transaction (check inventory, issue work orders, and so on). Business functions also
contain the application programming interfaces (APIs) that enable them to be called
from a form, a database trigger, or a non-JD Edwards EnterpriseOne application.
Business functions can be combined with other business functions, forms, event rules,
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and other components to make up an application. Business functions can be created
through event rules or third-generation languages, such as C. Examples of business
functions include Credit Check and Item Availability.

business function event rule See named event rule (NER).

business view A means for selecting specific columns from one or more JD Edwards EnterpriseOne
application tables whose data is used in an application or report. A business view
does not select specific rows, nor does it contain any actual data. It is strictly a view
through which you can manipulate data.

central objects merge A process that blends a customer’s modifications to the objects in a current release
with objects in a new release.

central server A server that has been designated to contain the originally installed version of the
software (central objects) for deployment to client computers. In a typical JD
Edwards EnterpriseOne installation, the software is loaded on to one machine—the
central server. Then, copies of the software are pushed out or downloaded to various
workstations attached to it. That way, if the software is altered or corrupted through its
use on workstations, an original set of objects (central objects) is always available
on the central server.

charts Tables of information in JD Edwards EnterpriseOne that appear on forms in the
software.
connector Component-based interoperability model that enables third-party applications and

JD Edwards EnterpriseOne to share logic and data. The JD Edwards EnterpriseOne
connector architecture includes Java and COM connectors.

contra/clearing account A general ledger account in JD Edwards EnterpriseOne Financial Management that
is used by the system to offset (balance) journal entries. For example, you can use a
contra/clearing account to balance the entries created by allocations in JD Edwards
EnterpriseOne Financial Management.

Control Table Workbench An application that, during the Installation Workbench processing, runs the batch
applications for the planned merges that update the data dictionary, user-defined
codes, menus, and user override tables.

control tables merge A process that blends a customer’s modifications to the control tables with the data that
accompanies a new release.

cost assignment The process in JD Edwards EnterpriseOne Advanced Cost Accounting of tracing or
allocating resources to activities or cost objects.

cost component In JD Edwards EnterpriseOne Manufacturing, an element of an item’s cost (for
example, material, labor, or overhead).

cross segment edit A logic statement that establishes the relationship between configured item segments.
Cross segment edits are used to prevent ordering of configurations that cannot be
produced.

currency restatement The process of converting amounts from one currency into another currency, generally

for reporting purposes. You can use the currency restatement process, for example,
when many currencies must be restated into a single currency for consolidated

reporting.
database server A server in a local area network that maintains a database and performs searches
for client computers.
Data Source Workbench An application that, during the Installation Workbench process, copies all data sources

that are defined in the installation plan from the Data Source Master and Table and
Data Source Sizing tables in the Planner data source to the system-release number data
source. It also updates the Data Source Plan detail record to reflect completion.
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date pattern

denominated-in currency

deployment server

detail information

direct connect

Do Not Translate (DNT)
dual pricing

edit code

edit mode

edit rule

Electronic Data Interchange

(EDI)

embedded event rule

Employee Work Center

enterprise server

EnterpriseOne object

EnterpriseOne process

Environment Workbench

escalation monitor

Glossary

A calendar that represents the beginning date for the fiscal year and the ending date for
each period in that year in standard and 52-period accounting.

The company currency in which financial reports are based.

A server that is used to install, maintain, and distribute software to one or more
enterprise servers and client workstations.

Information that relates to individual lines in JD Edwards EnterpriseOne transactions
(for example, voucher pay items and sales order detail lines).

A transaction method in which a client application communicates interactively and
directly with a server application.

See also batch-of-one immediate and store-and-forward.
A type of data source that must exist on the iSeries because of BLOB restrictions.
The process of providing prices for goods and services in two currencies.

A code that indicates how a specific value for a report or a form should appear or be
formatted. The default edit codes that pertain to reporting require particular attention
because they account for a substantial amount of information.

A condition of a form that enables users to change data.

A method used for formatting and validating user entries against a predefined rule
or set of rules.

An interoperability model that enables paperless computer-to-computer exchange of
business transactions between JD Edwards EnterpriseOne and third-party systems.
Companies that use EDI must have translator software to convert data from the EDI
standard format to the formats of their computer systems.

An event rule that is specific to a particular table or application. Examples include
form-to-form calls, hiding a field based on a processing option value, and calling a
business function. Contrast with the business function event rule.

A central location for sending and receiving all JD Edwards EnterpriseOne messages
(system and user generated), regardless of the originating application or user. Each
user has a mailbox that contains workflow and other messages, including Active
Messages.

A server that contains the database and the logic for JD Edwards EnterpriseOne.

A reusable piece of code that is used to build applications. Object types include tables,
forms, business functions, data dictionary items, batch processes, business views,
event rules, versions, data structures, and media objects.

A software process that enables JD Edwards EnterpriseOne clients and servers

to handle processing requests and run transactions. A client runs one process,

and servers can have multiple instances of a process. JD Edwards EnterpriseOne
processes can also be dedicated to specific tasks (for example, workflow messages
and data replication) to ensure that critical processes don’t have to wait if the server
is particularly busy.

An application that, during the Installation Workbench process, copies the
environment information and Object Configuration Manager tables for each
environment from the Planner data source to the system-release number data source. It
also updates the Environment Plan detail record to reflect completion.

A batch process that monitors pending requests or activities and restarts or forwards
them to the next step or user after they have been inactive for a specified amount of
time.
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event rule

facility

fast path

file server

final mode

FTP server

header information

interface table

integration server

integrity test

interoperability model

in-your-face-error

IServer service

jargon

Java application server

JDBNET

JDEBASE Database
Middleware

JDECallObject

jde.ini

JDEIPC

A logic statement that instructs the system to perform one or more operations based
on an activity that can occur in a specific application, such as entering a form or
exiting a field.

An entity within a business for which you want to track costs. For example, a facility
might be a warehouse location, job, project, work center, or branch/plant. A facility is
sometimes referred to as a “business unit.”

A command prompt that enables the user to move quickly among menus and
applications by using specific commands.

A server that stores files to be accessed by other computers on the network. Unlike
a disk server, which appears to the user as a remote disk drive, a file server is a
sophisticated device that not only stores files, but also manages them and maintains
order as network users request files and make changes to these files.

The report processing mode of a processing mode of a program that updates or
creates data records.

A server that responds to requests for files via file transfer protocol.

Information at the beginning of a table or form. Header information is used to identify
or provide control information for the group of records that follows.

See Z table.

A server that facilitates interaction between diverse operating systems and applications
across internal and external networked computer systems.

A process used to supplement a company’s internal balancing procedures by locating
and reporting balancing problems and data inconsistencies.

A method for third-party systems to connect to or access JD Edwards EnterpriseOne.

In JD Edwards EnterpriseOne, a form-level property which, when enabled, causes the
text of application errors to appear on the form.

This internet server service resides on the web server and is used to speed up delivery
of the Java class files from the database to the client.

An alternative data dictionary item description that JD Edwards EnterpriseOne appears
based on the product code of the current object.

A component-based server that resides in the middle-tier of a server-centric
architecture. This server provides middleware services for security and state
maintenance, along with data access and persistence.

A database driver that enables heterogeneous servers to access each other’s data.

A JD Edwards EnterpriseOne proprietary database middleware package that provides
platform-independent APIs, along with client-to-server access.

An API used by business functions to invoke other business functions.

A JD Edwards EnterpriseOne file (or member for iSeries) that provides the runtime
settings required for JD Edwards EnterpriseOne initialization. Specific versions of the
file or member must reside on every machine running JD Edwards EnterpriseOne.
This includes workstations and servers.

Communications programming tools used by server code to regulate access to the
same data in multiprocess environments, communicate and coordinate between
processes, and create new processes.
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jde.log The main diagnostic log file of JD Edwards EnterpriseOne. This file is always located
in the root directory on the primary drive and contains status and error messages from
the startup and operation of JD Edwards EnterpriseOne.

JDENET A JD Edwards EnterpriseOne proprietary communications middleware package. This
package is a peer-to-peer, message-based, socket-based, multiprocess communications
middleware solution. It handles client-to-server and server-to-server communications
for all JD Edwards EnterpriseOne supported platforms.

Location Workbench An application that, during the Installation Workbench process, copies all locations
that are defined in the installation plan from the Location Master table in the Planner
data source to the system data source.

logic server A server in a distributed network that provides the business logic for an application
program. In a typical configuration, pristine objects are replicated on to the logic
server from the central server. The logic server, in conjunction with workstations,
actually performs the processing required when JD Edwards EnterpriseOne software
runs.

MailMerge Workbench An application that merges Microsoft Word 6.0 (or higher) word-processing
documents with JD Edwards EnterpriseOne records to automatically print business
documents. You can use MailMerge Workbench to print documents, such as form
letters about verification of employment.

master business function (MBF) An interactive master file that serves as a central location for adding, changing, and
updating information in a database. Master business functions pass information
between data entry forms and the appropriate tables. These master functions provide a
common set of functions that contain all of the necessary default and editing rules for
related programs. MBF's contain logic that ensures the integrity of adding, updating,
and deleting information from databases.

master table See published table.

matching document A document associated with an original document to complete or change a transaction.
For example, in JD Edwards EnterpriseOne Financial Management, a receipt is the
matching document of an invoice, and a payment is the matching document of a
voucher.

media storage object Files that use one of the following naming conventions that are not organized into
table format: Gxxx, xxxGT, or GTxxx.

message center A central location for sending and receiving all JD Edwards EnterpriseOne messages
(system and user generated), regardless of the originating application or user.

messaging adapter An interoperability model that enables third-party systems to connect to JD Edwards
EnterpriseOne to exchange information through the use of messaging queues.

messaging server A server that handles messages that are sent for use by other programs using a
messaging API. Messaging servers typically employ a middleware program to perform
their functions.

named event rule (NER) Encapsulated, reusable business logic created using event rules, rather that C

programming. NERs are also called business function event rules. NERs can be reused
in multiple places by multiple programs. This modularity lends itself to streamlining,
reusability of code, and less work.

nota fiscal In Brazil, a legal document that must accompany all commercial transactions for tax
purposes and that must contain information required by tax regulations.

nota fiscal factura In Brazil, a nota fiscal with invoice information.

See also nota fiscal.
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Object Configuration Manager
(OCM)

Object Librarian

Object Librarian merge

Open Data Access (ODA)

Output Stream Access (OSA)

package

package build

package location

Package Workbench

planning family

preference profile

print server

pristine environment

In JD Edwards EnterpriseOne, the object request broker and control center for

the runtime environment. OCM keeps track of the runtime locations for business
functions, data, and batch applications. When one of these objects is called, OCM
directs access to it using defaults and overrides for a given environment and user.

A repository of all versions, applications, and business functions reusable in building
applications. Object Librarian provides check-out and check-in capabilities for
developers, and it controls the creation, modification, and use of JD Edwards
EnterpriseOne objects. Object Librarian supports multiple environments (such as
production and development) and enables objects to be easily moved from one
environment to another.

A process that blends any modifications to the Object Librarian in a previous release
into the Object Librarian in a new release.

An interoperability model that enables you to use SQL statements to extract JD
Edwards EnterpriseOne data for summarization and report generation.

An interoperability model that enables you to set up an interface for JD Edwards
EnterpriseOne to pass data to another software package, such as Microsoft Excel,
for processing.

JD Edwards EnterpriseOne objects are installed to workstations in packages from the
deployment server. A package can be compared to a bill of material or kit that indicates
the necessary objects for that workstation and where on the deployment server the
installation program can find them. It is point-in-time snapshot of the central objects
on the deployment server.

A software application that facilitates the deployment of software changes and new
applications to existing users. Additionally, in JD Edwards EnterpriseOne, a package
build can be a compiled version of the software. When you upgrade your version of the
ERP software, for example, you are said to take a package build.

Consider the following context: “Also, do not transfer business functions into the
production path code until you are ready to deploy, because a global build of business
functions done during a package build will automatically include the new functions.”
The process of creating a package build is often referred to, as it is in this example,
simply as “a package build.”

The directory structure location for the package and its set of replicated objects.
This is usually \\deployment server\release\path code\package\package name. The
subdirectories under this path are where the replicated objects for the package are
placed. This is also referred to as where the package is built or stored.

An application that, during the Installation Workbench process, transfers the package
information tables from the Planner data source to the system-release number data
source. It also updates the Package Plan detail record to reflect completion.

A means of grouping end items whose similarity of design and manufacture facilitates
being planned in aggregate.

The ability to define default values for specified fields for a user-defined hierarchy of
items, item groups, customers, and customer groups.

The interface between a printer and a network that enables network clients to connect
to the printer and send their print jobs to it. A print server can be a computer, separate
hardware device, or even hardware that resides inside of the printer itself.

A JD Edwards EnterpriseOne environment used to test unaltered objects with JD
Edwards EnterpriseOne demonstration data or for training classes. You must have this
environment so that you can compare pristine objects that you modify.

Copyright © 2006, Oracle. All rights reserved.



processing option

production environment

production-grade file server

program temporary fix (PTF)

project

promotion path

proxy server

published table

publisher

pull replication

QBE

real-time event

refresh

replication server

quote order

Glossary

A data structure that enables users to supply parameters that regulate the running of
a batch program or report. For example, you can use processing options to specify
default values for certain fields, to determine how information appears or is printed,
to specify date ranges, to supply runtime values that regulate program execution,
and so on.

A JD Edwards EnterpriseOne environment in which users operate EnterpriseOne
software.

A file server that has been quality assurance tested and commercialized and that is
usually provided in conjunction with user support services.

A representation of changes to JD Edwards EnterpriseOne software that your
organization receives on magnetic tapes or disks.

In JD Edwards EnterpriseOne, a virtual container for objects being developed in
Object Management Workbench.

The designated path for advancing objects or projects in a workflow. The following
is the normal promotion cycle (path):

11>21>26>28>38>01

In this path, // equals new project pending review, 2/ equals programming, 26 equals
QA test/review, 28 equals QA test/review complete, 38 equals in production, 0/ equals
complete. During the normal project promotion cycle, developers check objects out

of and into the development path code and then promote them to the prototype path
code. The objects are then moved to the productions path code before declaring

them complete.

A server that acts as a barrier between a workstation and the internet so that the
enterprise can ensure security, administrative control, and caching service.

Also called a master table, this is the central copy to be replicated to other machines.
Residing on the publisher machine, the FOSDRPUB table identifies all of the published
tables and their associated publishers in the enterprise.

The server that is responsible for the published table. The FO8DRPUB table identifies
all of the published tables and their associated publishers in the enterprise.

One of the JD Edwards EnterpriseOne methods for replicating data to individual
workstations. Such machines are set up as pull subscribers using JD Edwards
EnterpriseOne data replication tools. The only time that pull subscribers are notified of
changes, updates, and deletions is when they request such information. The request

is in the form of a message that is sent, usually at startup, from the pull subscriber to
the server machine that stores the FO8DRPCN table.

An abbreviation for query by example. In JD Edwards EnterpriseOne, the QBE line is
the top line on a detail area that is used for filtering data.

A service that uses system calls to capture JD Edwards EnterpriseOne transactions as
they occur and to provide notification to third-party software, end users, and other
JD Edwards EnterpriseOne systems that have requested notification when certain
transactions occur.

A function used to modify JD Edwards EnterpriseOne software, or subset of it, such
as a table or business data, so that it functions at a new release or cumulative update
level, such as B73.2 or B73.2.1.

A server that is responsible for replicating central objects to client machines.

In JD Edwards Procurement and Subcontract Management, a request from a supplier
for item and price information from which you can create a purchase order.
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selection

Server Workbench

spot rate

Specification merge

specification

Specification Table Merge
Workbench

store-and-forward

subscriber table

supplemental data

table access management
(TAM)

Table Conversion Workbench

table conversion

table event rules

terminal server

In JD Edwards Sales Order Management, item and price information for a customer
who has not yet committed to a sales order.

Found on JD Edwards EnterpriseOne menus, a selection represents functions that you
can access from a menu. To make a selection, type the associated number in the
Selection field and press Enter.

An application that, during the Installation Workbench process, copies the server
configuration files from the Planner data source to the system-release number data
source. It also updates the Server Plan detail record to reflect completion.

An exchange rate entered at the transaction level. This rate overrides the exchange rate
that is set up between two currencies.

A merge that comprises three merges: Object Librarian merge, Versions List merge,
and Central Objects merge. The merges blend customer modifications with data that
accompanies a new release.

A complete description of a JD Edwards EnterpriseOne object. Each object has its own
specification, or name, which is used to build applications.

An application that, during the Installation Workbench process, runs the batch
applications that update the specification tables.

The mode of processing that enables users who are disconnected from a server to enter
transactions and then later connect to the server to upload those transactions.

Table FO98DRSUB, which is stored on the publisher server with the FOSDRPUB table
and identifies all of the subscriber machines for each published table.

Any type of information that is not maintained in a master file. Supplemental data is
usually additional information about employees, applicants, requisitions, and jobs
(such as an employee’s job skills, degrees, or foreign languages spoken). You can track
virtually any type of information that your organization needs.

For example, in addition to the data in the standard master tables (the Address Book
Master, Customer Master, and Supplier Master tables), you can maintain other

kinds of data in separate, generic databases. These generic databases enable a
standard approach to entering and maintaining supplemental data across JD Edwards
EnterpriseOne systems.

The JD Edwards EnterpriseOne component that handles the storage and retrieval

of use-defined data. TAM stores information, such as data dictionary definitions;
application and report specifications; event rules; table definitions; business function
input parameters and library information; and data structure definitions for running
applications, reports, and business functions.

An interoperability model that enables the exchange of information between JD
Edwards EnterpriseOne and third-party systems using non-JD Edwards EnterpriseOne
tables.

An interoperability model that enables the exchange of information between JD
Edwards EnterpriseOne and third-party systems using non-JD Edwards EnterpriseOne
tables.

Logic that is attached to database triggers that runs whenever the action specified by
the trigger occurs against the table. Although JD Edwards EnterpriseOne enables
event rules to be attached to application events, this functionality is application
specific. Table event rules provide embedded logic at the table level.

A server that enables terminals, microcomputers, and other devices to connect to a
network or host computer or to devices attached to that particular computer.
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three-tier processing

three-way voucher match

transaction processing (TP)
monitor

transaction set

trigger

triggering event

two-way voucher match

User Overrides merge

variance

Version List merge

visual assist

vocabulary override

wchar_t

web application server

web server

Windows terminal server

Glossary

The task of entering, reviewing and approving, and posting batches of transactions in
JD Edwards EnterpriseOne.

In JD Edwards Procurement and Subcontract Management, the process of comparing
receipt information to supplier’s invoices to create vouchers. In a three-way match,
you use the receipt records to create vouchers.

A monitor that controls data transfer between local and remote terminals and the
applications that originated them. TP monitors also protect data integrity in the
distributed environment and may include programs that validate data and format
terminal screens.

An electronic business transaction (electronic data interchange standard document)
made up of segments.

One of several events specific to data dictionary items. You can attach logic to a data
dictionary item that the system processes automatically when the event occurs.

A specific workflow event that requires special action or has defined consequences
or resulting actions.

In JD Edwards Procurement and Subcontract Management, the process of comparing
purchase order detail lines to the suppliers’ invoices to create vouchers. You do not
record receipt information.

Adds new user override records into a customer’s user override table.

In JD Edwards Capital Asset Management, the difference between revenue generated
by a piece of equipment and costs incurred by the equipment.

In JD Edwards EnterpriseOne Project Costing and JD Edwards EnterpriseOne
Manufacturing, the difference between two methods of costing the same item (for
example, the difference between the frozen standard cost and the current cost is

an engineering variance). Frozen standard costs come from the Cost Components
table, and the current costs are calculated using the current bill of material, routing,
and overhead rates.

The Versions List merge preserves any non-XJDE and non-ZJDE version
specifications for objects that are valid in the new release, as well as their processing
options data.

Forms that can be invoked from a control via a trigger to assist the user in determining
what data belongs in the control.

An alternate description for a data dictionary item that appears on a specific JD
Edwards EnterpriseOne form or report.

An internal type of a wide character. It is used for writing portable programs for
international markets.

A web server that enables web applications to exchange data with the back-end
systems and databases used in eBusiness transactions.

A server that sends information as requested by a browser, using the TCP/IP set of
protocols. A web server can do more than just coordination of requests from browsers;
it can do anything a normal server can do, such as house applications or data. Any
computer can be turned into a web server by installing server software and connecting
the machine to the internet.

A multiuser server that enables terminals and minimally configured computers to
display Windows applications even if they are not capable of running Windows
software themselves. All client processing is performed centrally at the Windows
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workbench

work day calendar

workflow

workgroup server

XAPI events

XML CallObject
XML Dispatch

XML List

XML Service

XML Transaction

XML Transaction Service

(XTS)

Z event

Z table

Z transaction

terminal server and only display, keystroke, and mouse commands are transmitted over
the network to the client terminal device.

A program that enables users to access a group of related programs from a single entry
point. Typically, the programs that you access from a workbench are used to complete
a large business process. For example, you use the JD Edwards EnterpriseOne

Payroll Cycle Workbench (P07210) to access all of the programs that the system uses
to process payroll, print payments, create payroll reports, create journal entries,

and update payroll history. Examples of JD Edwards EnterpriseOne workbenches
include Service Management Workbench (P90CD020), Line Scheduling Workbench
(P3153), Planning Workbench (P13700), Auditor’s Workbench (PO9E115), and
Payroll Cycle Workbench.

In JD Edwards EnterpriseOne Manufacturing, a calendar that is used in planning
functions that consecutively lists only working days so that component and work order
scheduling can be done based on the actual number of work days available. A work
day calendar is sometimes referred to as planning calendar, manufacturing calendar, or
shop floor calendar.

The automation of a business process, in whole or in part, during which documents,
information, or tasks are passed from one participant to another for action, according
to a set of procedural rules.

A server that usually contains subsets of data replicated from a master network server.
A workgroup server does not perform application or batch processing.

A service that uses system calls to capture JD Edwards EnterpriseOne transactions
as they occur and then calls third-party software, end users, and other JD Edwards
EnterpriseOne systems that have requested notification when the specified
transactions occur to return a response.

An interoperability capability that enables you to call business functions.

An interoperability capability that provides a single point of entry for all XML
documents coming into JD Edwards EnterpriseOne for responses.

An interoperability capability that enables you to request and receive JD Edwards
EnterpriseOne database information in chunks.

An interoperability capability that enables you to request events from one JD Edwards
EnterpriseOne system and receive a response from another JD Edwards EnterpriseOne
system.

An interoperability capability that enables you to use a predefined transaction type to
send information to or request information from JD Edwards EnterpriseOne. XML
transaction uses interface table functionality.

Transforms an XML document that is not in the JD Edwards EnterpriseOne format
into an XML document that can be processed by JD Edwards EnterpriseOne. XTS
then transforms the response back to the request originator XML format.

A service that uses interface table functionality to capture JD Edwards EnterpriseOne
transactions and provide notification to third-party software, end users, and other JD
Edwards EnterpriseOne systems that have requested to be notified when certain
transactions occur.

A working table where non-JD Edwards EnterpriseOne information can be stored and
then processed into JD Edwards EnterpriseOne. Z tables also can be used to retrieve
JD Edwards EnterpriseOne data. Z tables are also known as interface tables.

Third-party data that is properly formatted in interface tables for updating to the
JD Edwards EnterpriseOne database.
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quick list 37

role 37

send to one person 36

JD Edwards EnterpriseOne Software
entry points 3
JD Edwards EnterpriseOne Software
Access 3
JD Edwards EnterpriseOne software
features 3
adaptability 3
integrated supply chain 3
interoperability 3
multiplatform computing 3
user-friendly 3
JD Edwards EnterpriseOne systems 75
JD Edwards software application suites 4

keyboard hot keys 67
keyboard shortcuts 67
calendar tool 70
hot keys 67
media object text 71
web client calendar tool 71

logs, viewing 46

mailmerge documents 61
mailmerge templates 61
media objects 48, 50
attaching a shortcut 52
attaching a template 55
attaching an image object 51
attaching an OLE object 51
attaching media objects 50
attaching OLE objects at the base form
level 59
attaching text objects 50
checking for attachments 49
creating a template 55
deleting a template 55
deleting a template on media objects 56
deleting media objects 54

deleting OLE objects at the base form
level 60
image files 47
modifying a template 55
object linking and embedding
(OLE) 47
overview 47
properties of media objects 56
setting image properties 57
setting media object properties 56
setting media object text properties 57
setting shortcut properties 58
templates 54
text files 47
viewing OLE properties 57
message box 8
messages 40
accessing the employee work center 39
cancel delivery to a specific queue 41
deleting messages 42
internal and external messages 31
internal message 36
See Also send to one person
moving message to another queue 41
moving to another queue 41
print a report of all messages in a
queue 42
printing messages 42
reassigning 41
redirecting messages 41
revising 40
send shortcut 38
sending 40
sending internal messages 35, 37
See Also quick lists
understanding queues 32
viewing messages 40
Work Item Manager 31
workflow messages 32
working with shortcuts 37
messages and queues 31
metadata for an attachment, define 58

notes Xv

OLE objects
as media objects 50
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OLE properties 57
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